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+++

:

Abstract (The abstract should not exceed 250 words. It should briefly summarize the essence of the paper and address the
following areas without using specific subsection titles.): Objective: Briefly state the problem or issue addressed, in language
accessible to a general scientific audience. Technology or Method: Briefly summarize the technological innovation or method
used to address the problem. Results: Provide a brief summary of the results and findings. Conclusions: Give brief concluding
remarks on your outcomes. Clinical Impact: Comment on the translational aspect of the work presented in the paper and its
potential clinical impact. Detailed discussion of these aspects should be provided in the main body of the paper.

(Note that the organization of the body of the paper is at the authors’ discretion; the only required sections are Introduction,
Methods and Procedures, Results, Conclusion, and References. Acknowledgements and Appendices are encouraged but optional.)

Index Terms—At least four keywords or phrases in alphabetical order, separated by commas. For a list of suggested keywords, send a
blank e-mail to keywords@ieee.org or visit http://www.ieee.org/organizations/pubs/ani_prod/keywrd98.txt\

Note: There should no nonstandard abbreviations, acknowledgments of support, references or footnotes in in the abstract.

I. INTRODUCTION1

HIS document is a template for Microsoft Word versions 6.0 or later. If you are reading a paper or PDF version of this
document, please download the electronic file from the IEEE Web site at

1 This paragraph of the first footnote will contain the date on which you submitted your paper for review. It will also contain support information, including
sponsor and financial support acknowledgment. For example, “This work was supported in part by the U.S. Department of Commerce under Grant BS123456”.

The next few paragraphs should contain the authors’ current affiliations, including current address and e-mail. For example, F. A. Author is with the National
Institute of Standards and Technology, Boulder, CO 80305 USA (e-mail: author@ boulder.nist.gov).

S. B. Author, Jr., was with Rice University, Houston, TX 77005 USA. He is now with the Department of Physics, Colorado State University, Fort Collins, CO
80523 USA (e-mail: author@lamar.colostate.edu).

T. C. Author is with the Electrical Engineering Department, University of Colorado, Boulder, CO 80309 USA, on leave from the National Research Institute
for Metals, Tsukuba, Japan (e-mail: author@nrim.go.jp).
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http://www.ieee.org/web/publications/authors/jtehm/index.html so you can use it to prepare your manuscript.
When you open the template, select “Page Layout” from the “View” menu in the menu bar

which allows you to see the footnotes. Then, type over sections of the template or cut and paste from another document and use
markup styles. The pull-down style menu is at the left of the Formatting Toolbar at the top of your Word window (for example,
the style at this point in the document is “Text”). Highlight a section that you want to designate with a certain style, then select
the appropriate name on the style menu. The style will adjust your fonts and line spacing. Do not change the font sizes or line
spacing to squeeze more text into a limited number of pages. Use italics for emphasis; do not underline.
To insert images in Word, position the cursor at the insertion point and either use Insert | Picture | From File or copy the image

to the Windows clipboard and then Edit | Paste Special | Picture (with “float over text” unchecked).
IEEE will do the final formatting of your paper. If your paper is intended for a conference, please observe the conference page

limits.

II. PROCEDURES FOR PAPER SUBMISSION

A. Review Stage
Please check with your editor on whether to submit your manuscript as hard copy or electronically for review. If hard copy,

submit photocopies such that only one column appears per page. This will give your referees plenty of room to write comments.
Send the number of copies specified by your editor (typically four). If submitted electronically, find out if your editor prefers
submissions on disk or as e-mail attachments.
If you want to submit your file with one column electronically, please do the following:

--First, click on the View menu and choose Print Layout.
--Second, place your cursor in the first paragraph. Go to the Format menu, choose Columns, choose one column Layout,

and choose “apply to whole document” from the dropdown menu.
--Third, click and drag the right margin bar to just over 4 inches in width.

The graphics will stay in the “second” column, but you can drag them to the first column. Make the graphic wider to push out
any text that may try to fill in next to the graphic.

B. Final Stage
When you submit your final version (after your paper has been accepted), print it in two-column format, including figures and

tables. You must also send your final manuscript on a disk, via e-mail, or through a Web manuscript submission system as
directed by the society contact. You may use Zip or CD-ROM disks for large files, or compress files using Compress, Pkzip,
Stuffit, or Gzip.
Also, send a sheet of paper or PDF with complete contact information for all authors. Include full mailing addresses, telephone

numbers, fax numbers, and e-mail addresses. This information will be used to send each author a complimentary copy of the
journal in which the paper appears. In addition, designate one author as the “corresponding author.” This is the author to whom
proofs of the paper will be sent. Proofs are sent to the corresponding author only.

C. Figures
Format and save your graphic images using a suitable graphics processing program that will allow you to create the images as

PostScript (PS), Encapsulated PostScript (EPS), or Tagged Image File Format (TIFF), sizes them, and adjusts the resolution
settings. If you created your source files in one of the following you will be able to submit the graphics without converting to a
PS, EPS, or TIFF file: Microsoft Word, Microsoft PowerPoint, Microsoft Excel, or Portable Document Format (PDF).

D. Electronic Image Files (Optional)
Import your source files in one of the following: Microsoft Word, Microsoft PowerPoint, Microsoft Excel, or Portable

Document Format (PDF); you will be able to submit the graphics without converting to a PS, EPS, or TIFF files. Image quality is
very important to how yours graphics will reproduce. Even though we can accept graphics in many formats, we cannot improve
your graphics if they are poor quality when we receive them. If your graphic looks low in quality on your printer or monitor,
please keep in mind that cannot improve the quality after submission.
If you are importing your graphics into this Word template, please use the following steps:
Under the option EDIT select PASTE SPECIAL. A dialog box will open, select paste picture, then click OK. Your figure

should now be in the Word Document.
If you are preparing images in TIFF, EPS, or PS format, note the following. High-contrast line figures and tables should be

prepared with 600 dpi resolution and saved with no compression, 1 bit per pixel (monochrome), with file names in the form of
“fig3.tif” or “table1.tif.”

http://www.ieee.org/web/publications/authors/jtehm/index.html
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Photographs and grayscale figures should be prepared with 300 dpi resolution and saved with no compression, 8 bits per pixel
(grayscale).

Sizing of Graphics
Most charts graphs and tables are one column wide (3 1/2 inches or 21 picas) or two-column width (7 1/16 inches, 43 picas

wide). We recommend that you avoid sizing figures less than one column wide, as extreme enlargements may distort your
images and result in poor reproduction. Therefore, it is better if the image is slightly larger, as a minor reduction in size should
not have an adverse affect the quality of the image.

Size of Author Photographs
The final printed size of an author photograph is exactly

1 inch wide by 1 1/4 inches long (6 picas × 7 1/2 picas). Please ensure that the author photographs you submit are proportioned
similarly. If the author’s photograph does not appear at the end of the paper, then please size it so that it is proportional to the
standard size of 1 9/16 inches wide by
2 inches long (9 1/2 picas × 12 picas). JPEG files are only accepted for author photos.

How to create a PostScript File
First, download a PostScript printer driver from http://www.adobe.com/support/downloads/pdrvwin.htm (for Windows) or

from http://www.adobe.com/support/downloads/ pdrvmac.htm (for Macintosh) and install the “Generic PostScript Printer”
definition. In Word, paste your figure into a new document. Print to a file using the PostScript printer driver. File names should
be of the form “fig5.ps.” Use Open Type fonts when creating your figures, if possible. A listing of the acceptable fonts are as
follows: Open Type Fonts: Times Roman, Helvetica, Helvetica Narrow, Courier, Symbol, Palatino, Avant Garde, Bookman,
Zapf Chancery, Zapf Dingbats, and New Century Schoolbook.

Print Color Graphics Requirements
IEEE accepts color graphics in the following formats: EPS, PS, TIFF, Word, PowerPoint, Excel, and PDF. The resolution of a

RGB color TIFF file should be 400 dpi.
When sending color graphics, please supply a high quality hard copy or PDF proof of each image. If we cannot achieve a

satisfactory color match using the electronic version of your files, we will have your hard copy scanned. Any of the files types
you provide will be converted to RGB color EPS files.

Web Color Graphics
IEEE accepts color graphics in the following formats: EPS, PS, TIFF, Word, PowerPoint, Excel, and PDF. The resolution of a

RGB color TIFF file should be at least 400 dpi.
Your color graphic will be converted to grayscale if no separate grayscale file is provided. If a graphic is to appear in print as

black and white, it should be saved and submitted as a black and white file. If a graphic is to appear in print or on IEEE Xplore in
color, it should be submitted as RGB color.

Graphics Checker Tool
The IEEE Graphics Checker Tool enables users to check graphic files. The tool will check journal article graphic files against

a set of rules for compliance with IEEE requirements. These requirements are designed to ensure sufficient image quality so
they will look acceptable in print. After receiving a graphic or a set of graphics, the tool will check the files against a set of rules.
A report will then be e-mailed listing each graphic and whether it met or failed to meet the requirements. If the file fails, a
description of why and instructions on how to correct the problem will be sent. The IEEE Graphics Checker Tool is available at
http://graphicsqc.ieee.org/
For more Information, contact the IEEE Graphics H-E-L-P Desk by e-mail at graphics@ieee.org. You will then receive an e-

mail response and sometimes a request for a sample graphic for us to check.

http://www.adobe.com/support/downloads/pdrvwin.htm
http://www.adobe.com/support/downloads/
http://graphicsqc.ieee.org/
mailto:graphics@ieee.org
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E. Copyright Form
An IEEE copyright form should accompany your final

submission. You can get a .pdf, .html, or .doc version at
http://www.ieee.org/copyright. Authors are responsible for
obtaining any security clearances.

III. MATH

If you are using Word, use either the Microsoft Equation Editor or the MathType add-on (http://www.mathtype.com) for
equations in your paper (Insert | Object | Create New | Microsoft Equation or MathType Equation). “Float over text” should not
be selected.

IV. UNITS

Use either SI (MKS) or CGS as primary units. (SI units are strongly encouraged.) English units may be used as secondary
units (in parentheses). This applies to papers in data storage. For example, write “15 Gb/cm2 (100 Gb/in2).” An exception is
when English units are used as identifiers in trade, such as “3½-in disk drive.” Avoid combining SI and CGS units, such as
current in amperes and magnetic field in oersteds. This often leads to confusion because equations do not balance dimensionally.
If you must use mixed units, clearly state the units for each quantity in an equation.
The SI unit for magnetic field strength H is A/m. However, if you wish to use units of T, either refer to magnetic flux density

B or magnetic field strength symbolized as µ0H. Use the center dot to separate compound units, e.g., “A·m2.”

V. HELPFUL HINTS

A. Figures and Tables
Because IEEE will do the final formatting of your paper, you do not need to position figures and tables at the top and bottom

of each column. Large figures and tables may span both columns. Place figure captions below the figures; place table titles above
the tables. If your figure has two parts, include the labels “(a)” and “(b)” as part of the artwork. Please verify that the figures and
tables you mention in the text actually exist. Please do not include captions as part of the figures. Do not put captions in
“text boxes” linked to the figures. Do not put borders around the outside of your figures. Use the abbreviation “Fig.” even
at the beginning of a sentence. Do not abbreviate “Table.” Tables are numbered with Roman numerals.
Figure axis labels are often a source of confusion. Use words rather than symbols. As an example, write the quantity

“Magnetization,” or “Magnetization M,” not just “M.” Put units in parentheses. Do not label axes only with units. As in Fig. 1,
for example, write “Magnetization (A/m)” or “Magnetization (Am  1),” not just “A/m.” Do not label axes with a ratio of

TABLE I
UNITS FORMAGNETIC PROPERTIES

Symbol Quantity Conversion from Gaussian and
CGS EMU to SI a

 magnetic flux 1 Mx 108 Wb = 108 V·s
B magnetic flux density,

magnetic induction
1 G 104 T = 104 Wb/m2

H magnetic field strength 1 Oe 103/(4) A/m
m magnetic moment 1 erg/G = 1 emu

 103 A·m2 = 103 J/T
M magnetization 1 erg/(G·cm3) = 1 emu/cm3

 103 A/m
4M magnetization 1 G 103/(4) A/m
 specific magnetization 1 erg/(G·g) = 1 emu/g 1 A·m2/kg
j magnetic dipole

moment
1 erg/G = 1 emu
 4  1010 Wb·m

J magnetic polarization 1 erg/(G·cm3) = 1 emu/cm3

 4  104 T
,  susceptibility 1 4
 mass susceptibility 1 cm3/g 4  103 m3/kg
 permeability 1 4  107 H/m

= 4  107 Wb/(A·m)
r relative permeability   r
w, W energy density 1 erg/cm3  101 J/m3

N, D demagnetizing factor 1 1/(4)

Vertical lines are optional in tables. Statements that serve as captions for
the entire table do not need footnote letters.

aGaussian units are the same as cgs emu for magnetostatics; Mx =
maxwell, G = gauss, Oe = oersted; Wb = weber, V = volt, s = second, T =
tesla, m = meter, A = ampere, J = joule, kg = kilogram, H = henry.

Fig. 1. Magnetization as a function of applied field. Note that “Fig.” is
abbreviated. There is a period after the figure number, followed by two
spaces. It is good practice to explain the significance of the figure in the
caption.

http://www.ieee.org/copyright
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quantities and units. For example, write “Temperature (K),” not “Temperature/K.”
Multipliers can be especially confusing. Write “Magnetization (kA/m)” or “Magnetization (103 A/m).” Do not write

“Magnetization (A/m)  1000” because the reader would not know whether the top axis label in Fig. 1 meant 16000 A/m or
0.016 A/m. Figure labels should be legible, approximately 8 to 12 point type.

B. References
Number citations consecutively in square brackets [1]. The sentence punctuation follows the brackets [2]. Multiple references

[2], [3] are each numbered with separate brackets [1]–[3]. When citing a section in a book, please give the relevant page numbers
[2]. In sentences, refer simply to the reference number, as in [3]. Do not use “Ref. [3]” or “reference [3]” except at the beginning
of a sentence: “Reference [3] shows ... .” Please do not use automatic endnotes in Word, rather, type the reference list at the end
of the paper using the “References” style.
Number footnotes separately in superscripts (Insert | Footnote).2 Place the actual footnote at the bottom of the column in which

it is cited; do not put footnotes in the reference list (endnotes). Use letters for table footnotes (see Table I).
Please note that the references at the end of this document are in the preferred referencing style. Give all authors’ names; do

not use “et al.” unless there are six authors or more. Use a space after authors’ initials. Papers that have not been published
should be cited as “unpublished” [4]. Papers that have been accepted for publication, but not yet specified for an issue should be
cited as “to be published” [5]. Papers that have been submitted for publication should be cited as “submitted for publication” [6].
Please give affiliations and addresses for private communications [7].
Capitalize only the first word in a paper title, except for proper nouns and element symbols. For papers published in translation

journals, please give the English citation first, followed by the original foreign-language citation [8].

C. Abbreviations and Acronyms
Define abbreviations and acronyms the first time they are used in the text, even after they have already been defined in the

abstract. Abbreviations such as IEEE, SI, ac, and dc do not have to be defined. Abbreviations that incorporate periods should not
have spaces: write “C.N.R.S.,” not “C. N. R. S.” Do not use abbreviations in the title unless they are unavoidable (for example,
“IEEE” in the title of this article).

D. Equations
Number equations consecutively with equation numbers in parentheses flush with the right margin, as in (1). First use the

equation editor to create the equation. Then select the “Equation” markup style. Press the tab key and write the equation number
in parentheses. To make your equations more compact, you may use the solidus ( / ), the exp function, or appropriate exponents.
Use parentheses to avoid ambiguities in denominators. Punctuate equations when they are part of a sentence, as in

(1)

Be sure that the symbols in your equation have been defined before the equation appears or immediately following. Italicize
symbols (T might refer to temperature, but T is the unit tesla). Refer to “(1),” not “Eq. (1)” or “equation (1),” except at the
beginning of a sentence: “Equation (1) is ... .”

E. Other Recommendations
Use one space after periods and colons. Hyphenate complex modifiers: “zero-field-cooled magnetization.” Avoid dangling

participles, such as, “Using (1), the potential was calculated.” [It is not clear who or what used (1).] Write instead, “The potential
was calculated by using (1),” or “Using (1), we calculated the potential.”
Use a zero before decimal points: “0.25,” not “.25.” Use “cm3,” not “cc.” Indicate sample dimensions as “0.1 cm  0.2 cm,”

not “0.1  0.2 cm2.” The abbreviation for “seconds” is “s,” not “sec.” Do not mix complete spellings and abbreviations of units:
use “Wb/m2” or “webers per square meter,” not “webers/m2.” When expressing a range of values, write “7 to 9” or “7-9,” not
“7~9.”
A parenthetical statement at the end of a sentence is punctuated outside of the closing parenthesis (like this). (A parenthetical

sentence is punctuated within the parentheses.) In American English, periods and commas are within quotation marks, like “this
period.” Other punctuation is “outside”! Avoid contractions; for example, write “do not” instead of “don’t.” The serial comma is
preferred: “A, B, and C” instead of “A, B and C.”
If you wish, you may write in the first person singular or plural and use the active voice (“I observed that ...” or “We observed

that ...” instead of “It was observed that ...”). Remember to check spelling. If your native language is not English, please get a
native English-speaking colleague to carefully proofread your paper.

2It is recommended that footnotes be avoided (except for the unnumbered footnote with the receipt date on the first page). Instead, try to integrate the footnote
information into the text.
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VI. SOME COMMONMISTAKES

The word “data” is plural, not singular. The subscript for the permeability of vacuum µ0 is zero, not a lowercase letter “o.” The
term for residual magnetization is “remanence”; the adjective is “remanent”; do not write “remnance” or “remnant.” Use the
word “micrometer” instead of “micron.” A graph within a graph is an “inset,” not an “insert.” The word “alternatively” is
preferred to the word “alternately” (unless you really mean something that alternates). Use the word “whereas” instead of
“while” (unless you are referring to simultaneous events). Do not use the word “essentially” to mean “approximately” or
“effectively.” Do not use the word “issue” as a euphemism for “problem.” When compositions are not specified, separate
chemical symbols by en-dashes; for example, “NiMn” indicates the intermetallic compound Ni0.5Mn0.5 whereas “Ni–Mn”
indicates an alloy of some composition NixMn1-x.
Be aware of the different meanings of the homophones “affect” (usually a verb) and “effect” (usually a noun), “complement”

and “compliment,” “discreet” and “discrete,” “principal” (e.g., “principal investigator”) and “principle” (e.g., “principle of
measurement”). Do not confuse “imply” and “infer.”
Prefixes such as “non,” “sub,” “micro,” “multi,” and “ultra” are not independent words; they should be joined to the words

they modify, usually without a hyphen. There is no period after the “et” in the Latin abbreviation “et al.” (it is also italicized).
The abbreviation “i.e.,” means “that is,” and the abbreviation “e.g.,” means “for example” (these abbreviations are not italicized).
An excellent style manual and source of information for science writers is [9]. A general IEEE style guide and an Information

for Authors are both available at http://www.ieee.org/web/publications/authors/transjnl/index.html

VII. EDITORIAL POLICY
Submission of a manuscript is not required for participation in a conference. Do not submit a reworked version of a paper you

have submitted or published elsewhere. Do not publish “preliminary” data or results. The submitting author is responsible for
obtaining agreement of all coauthors and any consent required from sponsors before submitting a paper. IEEE TRANSACTIONS
and JOURNALS strongly discourage courtesy authorship. It is the obligation of the authors to cite relevant prior work.
The Transactions and Journals Department does not publish conference records or proceedings. The TRANSACTIONS does

publish papers related to conferences that have been recommended for publication on the basis of peer review. As a matter of
convenience and service to the technical community, these topical papers are collected and published in one issue of the
TRANSACTIONS.
At least two reviews are required for every paper submitted. For conference-related papers, the decision to accept or reject a

paper is made by the conference editors and publications committee; the recommendations of the referees are advisory only.
Undecipherable English is a valid reason for rejection. Authors of rejected papers may revise and resubmit them to the
TRANSACTIONS as regular papers, whereupon they will be reviewed by two new referees.

VIII. PUBLICATION PRINCIPLES
The contents of IEEE TRANSACTIONS and JOURNALS are peer-reviewed and archival. The TRANSACTIONS publishes scholarly

articles of archival value as well as tutorial expositions and critical reviews of classical subjects and topics of current interest.
Authors should consider the following points:

1) Technical papers submitted for publication must advance the state of knowledge and must cite relevant prior work.
2) The length of a submitted paper should be commensurate with the importance, or appropriate to the complexity, of the work.

For example, an obvious extension of previously published work might not be appropriate for publication or might be
adequately treated in just a few pages.

3) Authors must convince both peer reviewers and the editors of the scientific and technical merit of a paper; the standards of
proof are higher when extraordinary or unexpected results are reported.

4) Because replication is required for scientific progress, papers submitted for publication must provide sufficient information
to allow readers to perform similar experiments or calculations and use the reported results. Although not everything need be
disclosed, a paper must contain new, useable, and fully described information. For example, a specimen’s chemical
composition need not be reported if the main purpose of a paper is to introduce a new measurement technique. Authors
should expect to be challenged by reviewers if the results are not supported by adequate data and critical details.

5) Papers that describe ongoing work or announce the latest technical achievement, which are suitable for presentation at a
professional conference, may not be appropriate for publication in a TRANSACTIONS or JOURNAL.

http://www.ieee.org/web/publications/authors/transjnl/index.html
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IX. CONCLUSION
Please include a brief summary of the possible clinical implications of your work in the conclusion section. Although a

conclusion may review the main points of the paper, do not replicate the abstract as the conclusion. Consider elaborating on the
translational importance of the work or suggest applications and extensions.

APPENDIX

Appendixes, if needed, appear before the acknowledgment.

ACKNOWLEDGMENT

The preferred spelling of the word “acknowledgment” in American English is without an “e” after the “g.” Use the singular
heading even if you have many acknowledgments. Avoid expressions such as “One of us (S.B.A.) would like to thank ... .”
Instead, write “F. A. Author thanks ... .” Sponsor and financial support acknowledgments are placed in the unnumbered
footnote on the first page, not here.
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[24] E. E. Reber, R. L. Michell, and C. J. Carter, “Oxygen absorption in the Earth’s atmosphere,” Aerospace Corp., Los Angeles, CA, Tech. Rep. TR-0200 (420-

46)-3, Nov. 1988.
[25] (Handbook style) Transmission Systems for Communications, 3rd ed., Western Electric Co., Winston-Salem, NC, 1985, pp. 44–60.
[26] Motorola Semiconductor Data Manual,Motorola Semiconductor Products Inc., Phoenix, AZ, 1989.
[27] (Basic Book/Monograph Online Sources) J. K. Author. (year, month, day). Title (edition) [Type of medium]. Volume (issue). Available:

http://www.(URL)

[28] J. Jones. (1991, May 10). Networks (2nd ed.) [Online]. Available: http://www.atm.com
[29] (Journal Online Sources style) K. Author. (year, month). Title. Journal [Type of medium]. Volume(issue), paging if given. Available:

http://www.(URL)
[30] R. J. Vidmar. (1992, August). On the use of atmospheric plasmas as electromagnetic reflectors. IEEE Trans. Plasma Sci. [Online]. 21(3). pp. 876–880.

Available: http://www.halcyon.com/pub/journals/21ps03-vidmar

First A. Author (M’76–SM’81–F’87) and the other authors may include biographies at the end of regular papers. Biographies are often not included in
conference-related papers. This author became a Member (M) of IEEE in 1976, a Senior Member (SM) in 1981, and a Fellow (F) in 1987. The first paragraph
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may contain a place and/or date of birth (list place, then date). Next, the author’s educational background is listed. The degrees should be listed with type of
degree in what field, which institution, city, state, and country, and year degree was earned. The author’s major field of study should be lower-cased.

The second paragraph uses the pronoun of the person (he or she) and not the author’s last name. It lists military and work experience, including
summer and fellowship jobs. Job titles are capitalized. The current job must have a location; previous positions may be listed without one. Information
concerning previous publications may be included. Try not to list more than three books or published articles. The format for listing publishers of a book within
the biography is: title of book (city, state: publisher name, year) similar to a reference. Current and previous research interests end the paragraph.

The third paragraph begins with the author’s title and last name (e.g., Dr. Smith, Prof. Jones, Mr. Kajor, Ms. Hunter). List any memberships in
professional societies other than the IEEE. Finally, list any awards and work for IEEE committees and publications. If a photograph is provided, the biography
will be indented around it. The photograph is placed at the top left of the biography. Personal hobbies will be deleted from the biography.

:

1National Institute of Standards and Technology, Boulder, CO 80305, USA
2Department of Electrical, Computer, and Energy Engineering, University of Colorado, Boulder, CO 80309, USA
3Department of Metallurgical and Materials Engineering, Colorado School of Mines, Golden, CO 80401, USA

4National Institute for Materials Science, Tsukuba, Ibaraki 305, Japan

These instructions give you guidelines for preparing papers for IEEE TRANSACTIONS ON MAGNETICS. Use this document as a
template if you are using Microsoft Word. Otherwise, use this document just for helpful information, and prepare your paper using
any word processor or LaTeX (the general IEEE LaTeX template is available at www.ieee.org/publications_standards/
publications/authors/author_templates.html). This Word template is useful for estimating the length of an article but it is optional. The
electronic file of your paper will be formatted further at IEEE. Paper titles should be written in uppercase and lowercase letters. Avoid
writing long formulas with subscripts in the title; short formulas that identify the elements are fine (e.g., “Nd-Fe-B”). Do not begin a
title with the word “On.” Avoid starting a title with articles like “The.” Full names of authors are much preferred but initials may be
used instead. Chinese, Japanese, and Korean authors are encouraged to include their names in native characters in parentheses after
their Romanized names. More information may be found at www.ieee.org/publications_standards/publications/authors/auth_names_
native_lang.pdf. Department names are optional in the affiliations. Do not give street addresses in the affiliations (except for authors
with no institutional affiliation). Define all symbols used in the abstract, and again in the text. Do not cite references in the abstract.

Preparation of Papers for IEEE TRANSACTIONS
ONMAGNETICS

(Revised May 2015)

First A. Author1,2, Second B. Author Jr.2, Senior Member, IEEE, and Third Author (第三著者)3,4,
Fellow, IEEE
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Index Terms—About four key words or phrases in alphabetical order, separated by commas.

X. INTRODUCTION
HIS DOCUMENT is a Microsoft Word template for IEEE TRANSACTIONS ON MAGNETICS. Use of this document as a template
is optional. If you are reading a paper version of this document, please download the electronic file, TRANSMAG2015.DOC,

from www.ieee.org/publications_ standards/publications/authors/author_templates.html so you can use it to prepare your
manuscript. If you would prefer to use LaTeX, download IEEE’s LaTeX style and sample files from the same Web page. Use
those LaTeX files for formatting, but please follow the instructions in TRANSMAG2015.DOC (or TRANSMAG2015.PDF).
Authors may prepare their papers for review using any word processor, one or two columns, single or double spaced. Please

follow the writing style specified in this document.
When you open TRANSMAG2015.DOC, select “Print Layout” from the “View” menu in the menu bar (View > Print Layout).

Then type over sections of TRANSMAG2015.DOC or cut and paste from another document and then use markup styles (Home >
Styles). For example, the style at this point in the document is “Text”). Highlight a section that you want to designate with a
certain style; then select the appropriate name on the style menu. The style will adjust your fonts and line spacing. Use italics for
emphasis; do not underline.
To insert images in Word, position the cursor at the insertion point and either use Insert > Picture or copy the image to the

Windows clipboard and then Home > Paste. IEEE will do the final formatting of your paper, so do not worry about precisely
positioning figures and tables. In fact, they are best placed at the end of the paper, with the proper insertion points indicated in
the text.
If you have a question about formatting your paper, or a suggestion on improving these instructions, please contact

r.goldfarb@ieee.org.

XI. PROCEDURE FOR PAPER SUBMISSION

A. ScholarOne® Manuscripts
Authors of regular and conference-related papers should prepare their papers for review using Microsoft Word and this

template or LaTeX and the files contained in IEEEtran.zip. If your paper is submitted in conjunction with a conference, please
observe any page limits specified by the conference. Do not change the font sizes or line spacing to squeeze more text into a
limited number of pages. Leave some white space around your figures. Conference-related papers follow the same review
procedures as regular papers.
Regular and conference-related papers must be submitted electronically to IEEE’s on-line manuscript submission and peer-

review system, ScholarOne® Manuscripts. Regular papers should be submitted at mc.manuscriptcentral.com/ transmag-ieee; for
conference-related papers, go to mc.manuscriptcentral.com/magconf-ieee. You should first check if you have an existing
account. If there is none, please create a new account. (Your log-in information is the same on both sites.) After logging in, go to
your Author Center and click on the link, “Click here to submit a new manuscript.”
Along with other information, you will be asked to select the type of submission from a pull-down list. If you are submitting a

conference-related paper, choose the type appropriate for your conference. You will also be asked to select the subject of your
article. Additionally, conference authors are asked for the conference paper number. Using the format specific to your
conference, enter this number in the text box and also in the header at the top of this document.
There are 7 stages (screens) to the submission process; you must complete all 7 for a complete submission. At the end of each

stage you must click “Save and Continue”; simply uploading files is not sufficient. After step 7 you should see a confirmation
that the submission is complete. You should also receive an e-mail confirmation. For inquiries regarding the submission of your
paper on ScholarOne® Manuscripts, please contact oprs-support@ieee.org or call +1 732 465 5861.
ScholarOne® Manuscripts will accept files for review in the following formats: DOC, DOCX, RTF, PS, or PDF. PDF is

preferred at the review stage. If you used LaTeX to prepare your document, you must generate a PDF or PS file to upload to
ScholarOne® Manuscripts. Whatever format you upload, your figures should be embedded in the file, usually at the end.
You will be asked to file an electronic copyright form during the submission process. (Authors are responsible for obtaining

any security clearances.)

B. Final Submission
After your paper is accepted, you will be asked to upload final files to ScholarOne® Manuscripts. These will include your

DOC, DOCX, RTF, or LaTeX document source file with embedded figures; an additional PS or PDF file; and separate,
individual figure files. These individual files may be in any of the following formats: TIF (preferred), PDF (preferred), JPG, GIF,
EPS, DOC or DOCX (Microsoft Word, especially good for tables), or PPT (Microsoft PowerPoint, commonly used to make
figures). If you own Adobe Acrobat, please convert your DOC or DOCX tables and PPT figures to PDF (or click on “Create

T

http://www.ieee.org/publications_standards/publications/authors/author_templates.html
mailto:r.goldfarb@ieee.org
http://mc.manuscriptcentral.com/transmag-ieee
http://mc.manuscriptcentral.com/magconf-ieee
mailto:oprs-support@ieee.org
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Adobe PDF Online” at www.adobe.com). Figure and table files should be named following this convention: FIG1.TIF,
FIG2.PPT, FIG3.PDF, etc. See more about figure preparation in Section III below.
Also upload a file with complete contact information for all authors. Include full mailing addresses, telephone numbers, fax

numbers, and e-mail addresses. Designate the author who submitted the manuscript on ScholarOne® Manuscripts as the
“corresponding author.” This is the only author to whom proofs of the paper will be sent. You will have the option to designate
your article as “open access” in perpetuity if you agree to pay the IEEE open access fee.

C. Publication
About 1 week after your final files are submitted, your paper will appear in preprint form on IEEE Xplore®

(ieeexplore.ieee.org/xpl/mostRecentIssue.jsp?punumber=20) under “Early Access,” which will represent official publication.
PDF page proofs will be sent by e-mail to the corresponding author in 6 to 8 weeks. After you approve page proofs, the final

version of your article will be published on Xplore®.
Conference-related papers will all be published in a single issue of IEEE TRANSACTIONS ON MAGNETICS devoted to the

conference. If you return page proofs late, your paper will appear in a later issue, identified as a conference-related paper.

XII. ADVANCED INFORMATION ON CREATION OF ELECTRONIC IMAGE FILES
Most authors will be able to prepare images in one of the allowed formats listed above. This section provides optional,

additional information on preparing PS, EPS, and TIFF files. No matter how you convert your images, it is a good idea to print
the files to make sure nothing was lost in the process.
For more information on graphics files, please go to www.ieee.org/publications_standards/publications/authors/

authors_journals.html and click on the link “Using Microsoft Products or PDFs to Submit Graphics.”

A. IEEE Graphics Checker
Graphics Checker is part of the IEEE’s “Author Digital Toolbox,” a collection of tools for authors at

www.ieee.org/publications_standards/publications/authors/ authors_journals.html. The direct link for Graphics Checker is
graphicsqc.ieee.org. You can upload image files in batches of up to 10 to be analyzed and compared to IEEE’s requirements for
metadata, file size, file type, file naming, resolution parameters, and color format. You will receive a detailed report on the
usability of each image analyzed. The report will include an explanation of any error found, along with, when possible,
application-specific tips on how to fix the image. (You may ignore warnings that the author’s name is not part of the file name.)
For more Information, contact the IEEE Graphics Help Desk at graphics@ieee.org. You will receive an e-mail response and
sometimes a request for a sample graphic for IEEE to check.

B. Scanning Images to PS and EPS
If you have a scanner, a quick way to prepare figure files is to print your figures on paper exactly as you want them to appear,

scan them, and then save them to a file in PostScript (PS) or Encapsulated PostScript (EPS) formats. Use a separate file for each
image. File names should be of the form FIG1.PS or FIG2.EPS.

C. Scanning Images to TIFF
Using a scanner as above, you may save the images in TIFF format. The following specifications are the minimum

requirements for TIFF images; you may use higher resolution. As a rule, if your image file size is below 500 kB, your TIFF
image probably does not have enough resolution.
High-contrast line figures and tables should be prepared with at least 600 dpi resolution and saved with no compression, 1 bit

per pixel (monochrome), with file names of the form FIG3.TIF. To obtain a 3.45 inch figure (one column width) at 600 dpi, the
figure requires a horizontal size of 2070 pixels.
Photographs and grayscale figures should be prepared with at least 220 dpi resolution and saved with no compression, 8 bits

per pixel (grayscale). To obtain a 3.45 inch figure (one column width) at 220 dpi, the figure should have a horizontal size of 759
pixels.
Color figures should be prepared with at least 400 dpi resolution and saved with no compression, 8 bits per pixel (palette or

256 color). To obtain a 3.45 inch figure (one column width) at 400 dpi, the figure should have a horizontal size of 1380 pixels.

D. Printing images to PS Files
You may create PostScript figures by “printing” them to files. First, download a PostScript printer driver from

www.adobe.com/support/downloads/product.jsp?product= pdrv&platform=win (Windows) or www.adobe.com/support/
downloads/product.jsp?product=44&platform=Macintosh (Macintosh) and also install the “PPD Files: Adobe” printer definition.

http://www.adobe.com
http://ieeexplore.ieee.org/xpl/mostRecentIssue.jsp?punumber=20
http://www.ieee.org/publications_standards/publications/authors/authors_journals.html
http://www.ieee.org/publications_standards/publications/authors/authors_journals.html
http://www.ieee.org/publications_standards/publications/authors/authors_journals.html
http://graphicsqc.ieee.org/
mailto:graphics@ieee.org
http://www.adobe.com/support/downloads/product.jsp?product=%20pdrv&platform=win
http://www.adobe.com/support/%20downloads/product.jsp?product=44&platform=Macintosh
http://www.adobe.com/support/%20downloads/product.jsp?product=44&platform=Macintosh
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In Word, paste your figure into a new document. Print to a file using the PostScript printer driver. File names should be of the
form FIG5.PS. Use “Open Type” fonts when creating your figures, if possible: Times Roman, Helvetica, Helvetica Narrow,
Courier, Symbol, Palatino, Avant Garde, Bookman, Zapf Chancery, Zapf Dingbats, and New Century Schoolbook.

E. Converting PDF to TIFF
Experienced computer users can convert figures and tables from their original format to TIFF. Some useful image converters

are Adobe Photoshop, Corel Draw, Microsoft Photo Editor (part of Office 97 through Office XP), Picture Manager (Office
2003, 2007, 2010), and Photo Gallery (Office 2013). A free, versatile program for image manipulation and format conversion is
GIMP, available from www.gimp.org.
From Microsoft Office applications, such as PowerPoint, you may print or save as PDF. You may then convert a figure in the

PDF file to TIFF with Adobe Acrobat or Reader: View > Zoom to a large magnification (e.g., 1600%). Use the Snapshot Tool
to select the figure and copy it to the Windows clipboard. Open Microsoft Photo Editor, Edit > Paste as New Image, crop, and
adjust resolution as above. (If using Picture Manager, use Picture > Crop, Picture > Resize, File > Export.)
Note that the obvious way to convert PowerPoint PPT to TIFF (File > Save As > Save as type TIFF) gives poor results.
Alternatively, you may open the PDF in Photoshop or GIMP. Set the resolution to open at 1200 dpi. In GIMP, use “Export

As” and save in TIFF format with no compression.

F. Saving Files in TIFF
Most graphing programs allow you to save graphs in TIFF; however, you often have no control over compression or number

of bits per pixel. You should open these image files in a program such as Microsoft Photo Editor and re-save them using no
compression, either 1 or 8 bits, and either 600 or 220 dpi resolution (File > Properties; Image > Resize). See Section III.C for an
explanation of number of bits and resolution.

G. Using Print Screen
If your graphing program cannot export to TIFF, you can use the Print Screen function. Set your monitor to its highest

resolution. Adjust the magnification so that you can view the entire image on the screen. (In PowerPoint, you may use Slide
Show to get a full-screen image.) Move the cursor so it is out of the way. Press “Print Screen” on your keyboard; this copies the
screen image to the Windows clipboard. Open Microsoft Photo Editor and click Edit > Paste as New Image. Crop the image
(click Select button; select the part you want, then Image > Crop). Adjust the properties of the image (File > Properties) to get a
width of 3.45 inches. Save the file (File > Save As) in TIFF with no compression (click “More” button). Similar functionality is
available in GIMP and Photoshop.

XIII. UNITS

Use either SI (MKS) or CGS as primary units. (SI units are strongly encouraged.) English units may be used as secondary
units (in parentheses). This applies to papers in data storage. For example, write “15 Gbit/cm2 (100 Gbit/in2).” An exception is
when English units are used as identifiers in trade, such as “3½ in disk drive.” Avoid combining SI and CGS units, such as
current in amperes and magnetic field in oersteds. This often leads to confusion because equations do not balance dimensionally.
If you must use mixed units, clearly state the units for each quantity in an equation.
The SI unit for magnetic field strength H is A/m. However, if you wish to use units of T, either refer to magnetic flux density

B or magnetic field strength symbolized as µ0H. Use the center dot to separate compound units, e.g., “A·m2.”

XIV. HELPFUL HINTS

A. Editing Service
IEEE has partnered with SPi Publisher Services to offer pre-submission professional editing services to IEEE authors. SPi

copyedits and typesets more than 1 million pages per year for over 600 journals. Authors who would like assistance with
English grammar and usage prior to submitting their manuscripts for review or during the review process can go to www.prof-
editing.com/ieee to submit a manuscript for copyediting. A link is provided on the Manuscript Central Web site. SPi copyeditors
will edit for grammar, usage, organization, and clarity. Authors can use the service, at their own expense, as often as desired.
Cost estimates are available on-line, typically about $100 for a four-page article. Edited manuscripts are generally returned to
the authors within two weeks of submission.

B. Figures and Tables
Because IEEE will do the final formatting of your paper, you do not need to position figures and tables at the tops and

http://www.gimp.org
http://www.prof-editing.com/ieee/
http://www.prof-editing.com/ieee/
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bottoms of columns. In fact, all figures, figure captions, and tables can be at the end of the paper. Please mark in the text where
the figures and tables are supposed to appear. Large figures and tables may span both columns. Place figure captions below the
figures; place table captions above the tables. If your figure has two parts, for example, include the labels “(a)” and “(b)” as part
of the artwork. Please verify that figures and tables that you mention in the text actually exist. Please do not include captions as
part of the figures. Do not put captions in “text boxes” linked to the figures. Do not put borders around the outside of your
figures. Use the abbreviation “Fig.” even at the beginning of a sentence. Do not abbreviate “Table.” Tables are numbered with
Arabic numerals.

TABLE 1 HERE (Note white space above and below.)

C. Color Figures
There is no charge for color figures for the electronic (IEEE Xplore®) version of a paper. However, if any figures must be in

color for the print version of the paper, the cost is about $1300, depending on the number of figures and their placement. You
will be billed directly by IEEE. When you send the final version of their paper, you should indicate very clearly if you want
color in the print version. In the absence of such instructions, color will be used only for the electronic version. In that case,
please be certain that the black-and-white print version is understandable without the color information. If you want reprints of
your color article, the reprint order should be submitted promptly. There is an additional charge of $81 per 100 for color reprints.
Figure axis labels are often a source of confusion. Use words rather than symbols. As an example, write the quantity

“Magnetization,” or “Magnetization, M,” not just “M.” However, if there is not enough room on the axis to specify the quantity,
write just the symbol “M,” but define it in the figure caption.
IEEE allows two ways to designate units in graphs and tables: (1) Put units in parentheses. As in Fig. 1, for example, write

“Magnetization (A/m)” or “Magnetization, M (Am1)” (but not just “A/m”). (2) Label axes with a ratio of symbols and units.
For example, write “Magnetization, M/(Am1)” or “Temperature, T/K” (but not “Temperature/K”).
Multipliers can be especially confusing. Write “Magnetization (kA/m)” or “Magnetization (103 A/m).” Do not write

“Magnetization (A/m)  1000” because the reader would not know whether the top axis label in Fig. 1 meant 16000 A/m or
0.016 A/m. Figure labels should be legible, approximately 8 to 10 point type when reduced to journal column width.

FIG. 1 HERE (Note white space above and below.)

D. References
Number citations consecutively in square brackets [1]. The sentence punctuation follows the brackets [2]. Multiple references

[2], [3] are each numbered with separate brackets [1]-[3]. When citing a section in a book, please give the relevant page
numbers [2]. In sentences, refer simply to the reference number, as in [3]. Do not use “Ref. [3]” or “reference [3]” except at the
beginning of a sentence: “Reference [3] shows ... .” Unfortunately the IEEE document translator cannot handle automatic
endnotes in Word; therefore, type the reference list at the end of the paper using the “References” style.
Number footnotes separately in superscripts (Insert > Footnote).3 Place the actual footnote at the bottom of the column in

which it is cited; do not put footnotes in the reference list (endnotes). Use letters for table footnotes (see Table I).
Note that IEEE referencing style is quite different from that used by most physics journals. Give all authors’ names; do not

use “et al.” unless there are six authors or more. Use a space after authors’ initials. Papers that have not been published should
be cited as “unpublished” [4]. Papers that have been submitted for publication should be cited as “submitted for publication” [5].
(Since the paper may not be accepted, it is best to not specify the journal.) Papers that have been accepted for publication but not
yet assigned to an issue should be cited as “to be published” [6]. Please give affiliations and addresses for private
communications [7].
Capitalize only the first word in a paper title, except for proper nouns and element symbols. If you are preparing a

conference-related paper and are short of space, you may omit paper titles. However, paper titles are helpful to your readers and

3It is recommended that footnotes be avoided (except for the unnumbered footnote with the receipt date on the first page). Instead, try to integrate the
footnote information into the text.
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are strongly recommended. For papers published in translation journals, please give the English citation first, followed by the
original foreign-language citation [8].

E. Abbreviations and Acronyms
Define abbreviations and acronyms the first time they are used in the text, even after they have already been defined in the

abstract. Abbreviations such as IEEE, SI, ac, and dc do not have to be defined. Abbreviations that incorporate periods should not
have spaces: write “C.N.R.S.,” not “C. N. R. S.” Do not use abbreviations in the title unless they are unavoidable (for example,
“IEEE” in the title of this article).

F. Equations
If you are using Word, use either the Microsoft Equation Editor or the MathType add-on (www.dessci.com/en/products/

mathtype) for equations in your paper (Insert > Equation). Fit the equation into one column by breaking it as you wish it to
appear when typeset. You may find it convenient to create a new “equation” for each section of the equation.
Number equations consecutively with equation numbers in parentheses in the vicinity of the equation, as in (1). To make your

equations more compact, you may use the solidus ( / ), the exp function, or appropriate exponents. Use parentheses to avoid
ambiguities in denominators. Punctuate equations when they are part of a sentence, as in

.)()()||(exp
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Be sure that the symbols in your equation have been defined before the equation appears or immediately following. Italicize
symbols (T might refer to temperature, but T is the unit tesla). Refer to “(1),” not “Eq. (1)” or “equation (1),” except at the
beginning of a sentence: “Equation (1) is ... .”
Please confine equations to one column width and break equations at appropriate algebraic symbols.

G. Other Recommendations
Use one space after periods and colons. Hyphenate complex modifiers: “zero-field-cooled magnetization.” However, do not

hyphenate numbers and units: “10 nm thick film,” not “10-nm-thick film.” Avoid dangling participles, such as, “Using (1), the
potential was calculated.” [It is not clear who or what used (1).] Write instead, “The potential was calculated by using (1),” or
“Using (1), we calculated the potential.”
Use a zero before decimal points: “0.25,” not “.25.” Use “cm3,” not “cc.” Indicate sample dimensions as “0.1 cm  0.2 cm,”

not “0.1  0.2 cm2.” The abbreviation for “seconds” is “s,” not “sec.” Do not mix complete spellings and abbreviations of units:
use “Wb/m2” or “webers per square meter,” not “webers/m2.” When expressing a range of values, write “7 to 9” or “7–9,” not
“7~9.”
A parenthetical statement at the end of a sentence is punctuated outside of the closing parenthesis (like this). (A parenthetical

sentence is punctuated within the parentheses.) In American English, periods and commas are within quotation marks, like “this
period.” Other punctuation is “outside”! Avoid contractions; for example, write “do not” instead of “don’t.” The serial comma is
preferred: “A, B, and C” instead of “A, B and C.”
If you wish, you may write in the first person singular or plural (use the singular if you are the only author) and use the active

voice (“I observed that ...” or “We observed that ...” instead of “It was observed that ...”). Better still, omit statements of
observation and just report what you measured: “The susceptibility decreased with temperature” instead of “We observed that
the susceptibility decreased with temperature.” Similarly, avoid “We found that … .”
Remember to check spelling. If you are not fluent in English, please get a colleague to proofread your paper.

XV. SOME COMMON MISTAKES
The word “data” is plural, not singular. The subscript for the permeability of vacuum 0 is zero, not a lowercase letter “o.”

The term for residual magnetization is “remanence”; the adjective is “remanent”; do not write “remnance” or “remnant.” Use
the word “micrometer” instead of “micron.” A graph within a graph is an “inset,” not an “insert.” The word “alternatively” is
preferred to the word “alternately” (unless you really mean something that alternates). Use the word “whereas” instead of
“while” (unless you are referring to simultaneous events). Do not use the word “essentially” to mean “approximately” or
“effectively.” Do not use the word “issue” as a euphemism for “problem.”
Because “times” refers to multiplication, do not use the form “n times smaller”; instead, write “1/n times as large” or similar.

http://www.dessci.com/en/products/%20mathtype
http://www.dessci.com/en/products/%20mathtype
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For example, instead of “10 times smaller,” write “one tenth the size” or “0.1 times as large.” Do not use “times more”; instead,
write “times as much.” For example, “2 times more” could be interpreted as “3 times as much.”
When compositions are not specified, separate chemical symbols by hyphens; for example, “NiMn” indicates the

intermetallic compound Ni0.5Mn0.5 whereas “Ni-Mn” indicates an alloy of some composition NixMn1-x.
Be aware of the different meanings of the homophones “affect” (usually a verb) and “effect” (usually a noun), “complement”

and “compliment,” “discreet” and “discrete,” “principal” (e.g., “principal investigator”) and “principle” (e.g., “principle of
measurement”). Do not confuse “imply” and “infer.”
Prefixes such as “non,” “sub,” “micro,” and “ultra” are not independent words; they should be joined to the words they

modify, usually without a hyphen. There is no period after the “et” in the Latin abbreviation “et al.” The abbreviation “i.e.”
means “that is,” and the abbreviation “e.g.” means “for example.”
An excellent style manual and source of information for science writers is [9]. A general IEEE Style Manual is available at

www.ieee.org/publications_standards/ publications/authors/authors_journals.html. (The style for IEEE TRANSACTIONS ON
MAGNETICS differs in some respects.)

XVI. EDITORIAL POLICY
Submission of a manuscript is not required for participation in a conference. Do not submit a reworked version of a paper you

have submitted or published elsewhere, including conference papers. Do not submit “preliminary” data or results. The
submitting author is responsible for obtaining agreement of all coauthors and any consent required from sponsors before
submitting a paper. IEEE TRANSACTIONS ON MAGNETICS strongly discourages courtesy authorship. It is the obligation of the
authors to cite relevant prior work. If you copy sentences, paragraphs, figures, or tables from another paper, even if it is your
own paper, you must cite that paper at the corresponding point in your manuscript. IEEE’s plagiarism (and excessive duplication)
guidelines are described in detail at www.ieee.org/publications_standards/publications/rights.
The TRANSACTIONS does not publish conference records or proceedings. The TRANSACTIONS does publish papers related to

conferences on basic and applied magnetics that have been recommended for publication on the basis of peer review. As a
matter of convenience and service to the technical community, these topical papers are collected and published in one issue of
the TRANSACTIONS. Conference-related papers published in the TRANSACTIONS have the same peer-review requirements and the
same status as regular papers.
Occasionally authors wish to submit a regular manuscript based on a previously published paper that appeared in a conference

proceedings. Such submissions must contain a significant amount of new content, must cite the prior conference-proceedings
paper, and must state, in the text, what is new in the current manuscript.
At least two favorable reviews are required for a paper to be accepted for publication. In the event of an unfavorable review, it

is at the discretion of the editor whether to seek additional reviews. The editors additionally make a determination of suitability,
which is different from a judgment of whether a paper is sound or flawed. The editors consider whether a paper contributes
significant new material, is within the scope of the journal, or is more suited to another journal.
For conference-related papers, the decision to accept or reject a paper is made by the conference editors and publications

committee based on peer review and the scope of the conference. Undecipherable English is a valid reason for rejection.
Authors of rejected papers may revise and resubmit them to the TRANSACTIONS as regular papers, whereupon they will be
reviewed by two new referees.

XVII. PUBLICATION PRINCIPLES
IEEE TRANSACTIONS ON MAGNETICS is a peer-reviewed, archival journal in science and technology related to the basic

physics and engineering of magnetism, magnetic materials, applied magnetics, magnetic devices, and magnetic data storage.
The TRANSACTIONS publishes scholarly articles of archival value as well as tutorial expositions and critical reviews of classical
subjects and topics of current interest.
Authors should consider the following points:
1. Technical papers submitted for publication must advance the state of knowledge and must cite relevant prior work.
2. The length of a submitted paper should be commensurate with the importance, or appropriate to the complexity, of the

work. For example, an obvious extension of previously published work might not be appropriate for publication or might be
adequately treated in just a few pages.
3. Authors must convince both peer reviewers and the editors of the scientific and technical merit of a paper; the standards of

proof are higher when extraordinary or unexpected results are reported.
4. Because replication is required for scientific progress, papers submitted for publication must provide sufficient information

to allow readers to perform similar experiments or calculations and use the reported results. Although not everything need be

http://www.ieee.org/publications_standards/%20publications/authors/authors_journals.html
http://www.ieee.org/publications_standards/publications/rights
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disclosed, a paper must contain new, useable, and fully described information. For example, a specimen’s chemical composition
need not be reported if the main purpose of a paper is to introduce a new measurement technique. Authors should expect to be
challenged by reviewers if the results are not supported by adequate data and critical details.
5. Papers that describe ongoing work or announce the latest technical achievement, which are suitable for presentation at a

professional conference, may not be appropriate for publication in the TRANSACTIONS.

XVIII. CONCLUSION
A conclusion section is not required. Although a conclusion may review the main points of the paper, do not replicate the

abstract in the conclusion. A conclusion might elaborate on the importance of the work or suggest applications and extensions.

APPENDIX

Appendixes, if needed, appear before the acknowledgment.

ACKNOWLEDGMENT

The preferred spelling of the word “acknowledgment” in American English is without an “e” after the “g.” Use the singular
heading even if you have many acknowledgments. Avoid expressions such as “One of us (S.B.A.) would like to thank ... .”
Instead, write “S.B.A. thanks ... .” This work was supported in part by the U.S. Department of Commerce under Grant
BS123456 (sponsor and financial support acknowledgment goes here).
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Fig. 1. Magnetization as a function of applied field. Note that “Fig.” is
abbreviated. There is a period after the figure number, followed by two
spaces. It is good practice to explain the significance of the figure in the
caption.

TABLE I
UNITS FOR MAGNETIC PROPERTIES (SHORT TITLE HERE)

Symbol Quantity Conversion from Gaussian and
CGS EMU to SI a

 magnetic flux 1 Mx 108 Wb = 108 V·s
B magnetic flux density,

magnetic induction
1 G 104 T = 104 Wb/m2

H magnetic field strength 1 Oe 103/(4) A/m
m magnetic moment 1 erg/G = 1 emu

 103 A·m2 = 103 J/T
M magnetization 1 erg/(G·cm3) = 1 emu/cm3

 103 A/m
4M magnetization 1 G 103/(4) A/m
 specific magnetization 1 erg/(G·g) = 1 emu/g 1 A·m2/kg
j magnetic dipole

moment
1 erg/G = 1 emu
 4  1010 Wb·m

J magnetic polarization 1 erg/(G·cm3) = 1 emu/cm3

 4  104 T
,  susceptibility 1 4
 mass susceptibility 1 cm3/g 4  103 m3/kg
 permeability 1 4  107 H/m

= 4  107 Wb/(A·m)
r relative permeability   r
w, W energy density 1 erg/cm3  101 J/m3

N, D demagnetizing factor 1 1/(4)

No vertical lines in table. Statements that serve as captions for the entire
table do not need footnote letters. A longer description of the table would go
here.

aGaussian units are the same as cgs emu for magnetostatics; Mx =
maxwell, G = gauss, Oe = oersted; Wb = weber, V = volt, s = second, T =
tesla, m = meter, A = ampere, J = joule, kg = kilogram, H = henry.
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Abstract—These instructions give you guidelines for preparing papers for IEEE Magnetics Letters. Use this document
as a template if you are using Microsoft Word. Otherwise, use this document just for helpful information, and prepare
your paper using any word processor or LaTeX (the general IEEE LaTeX template is available at
www.ieee.org/publications_standards/publications/authors/author_templates.html). The Word template is useful for
estimating the length of an article (up to 4 pages of text plus an additional page for acknowledgment and references
are allowed) but it is optional. If you do not use the template, 4 journal pages have a total of about 3600 words; each
figure is equivalent to about 140 words. The electronic file of your paper will be formatted further at IEEE. Paper titles
should be written in uppercase and lowercase letters. Avoid writing long formulas with subscripts in the title; short
formulas that identify the elements are fine (e.g., “Nd-Fe-B”). Do not begin a title with the word “On.” Avoid starting a
title with articles like “The.” Full names of authors are much preferred over initials. Chinese, Japanese, and Korean
authors are encouraged to include their names in native characters in parentheses after their Romanized names. More
information may be found at www.ieee.org/publications_standards/publications/authors/auth_names_native_lang.pdf.
Department names are optional in the affiliations. Do not give street addresses in the affiliations (except for authors
with no institutional affiliation). Define all symbols used in the abstract, and again in the text. Do not cite references in
the abstract.

Index Terms—Approximately four key words or phrases in alphabetical order, separated by commas. The first one must be the
article’s main subject, which also appears at the top of this page in red. Main subjects include Electromagnetics, Magnetism in Solids,
Biomagnetics, Magnetochemistry, Magneto-Electronics, Spin Electronics, Magnetodynamics, Nanomagnetics, Information Storage,
Cryogenic Memory, Soft Magnetic Materials, Hard Magnetic Materials, Coupled Phenomena, and Magnetic Instruments. IEEE
Magnetics Letters currently does not accept articles on computational electromagnetics or motors. Articles related to certain
conferences have specific subject names. More details are available at mc.manuscriptcentral.com/maglet-ieee.

XIX. INTRODUCTION

This document is a Microsoft Word template for IEEE
Magnetics Letters. Use of this document as a template is optional.
If you are reading a paper version of this document, please
download the electronic file, MAGLET2016.DOCX, from
www.ieee.org/publications_standards/publications/authors/author_
templates.html so you can use it to prepare your manuscript. If you
would prefer to use LaTeX, download IEEE’s LaTeX style and
sample files from the same Web page. Use those LaTeX files for
formatting, but please follow the instructions in
MAGLET2016.DOCX (or MAGLET2016.PDF).
Authors may prepare their papers for review using any word

processor, one or two columns, single or double spaced. Please
follow the writing style specified in this document.
When you open MAGLET2016.DOCX, select “Print Layout” from

the “View” menu in the menu bar (View > Print Layout). Then
type over sections of MAGLET2016.DOCX or cut and paste from
another document and then use markup styles (Home > Styles).
For example, the style at this point in the document is “Text L-
MAG”). Highlight a section that you want to designate with a
certain style; then select the appropriate name on the style menu.
The style will adjust your fonts and line spacing. Use italics for
emphasis; do not underline. The font used for the text Magnetics
Letters is Times Roman.

Corresponding author: F. A. Author (f.author@nist.gov). If some authors
contributed equally, write here, “F. A. Author and S. B. Author contributed
equally.” IEEE Magnetics Letters discourages courtesy authorship; please
use the Acknowledgment section to thank your colleagues for routine
contributions.
Digital Object Identifier: 10.1109/LMAG.XXXX.XXXXXXX (inserted by IEEE).

Even though a Letter is limited to 4 pages of text, please use up
to two levels of section headings, which will improve the
readability of most articles.
To insert images in Word, position the cursor at the insertion

point and either use Insert > Picture or copy the image to the
Windows clipboard and then Home > Paste. IEEE will do the final
formatting of your paper, so do not worry about precisely
positioning figures and tables. In fact, they are best placed at the
end of the paper, with the proper insertion points indicated in the
text.
If you have a question about formatting your paper, or a

suggestion on improving these instructions, please contact
r.goldfarb@ieee.org.

XX. PROCEDURE FOR PAPER SUBMISSION

A. ScholarOne®Manuscripts

Contributions to Magnetics Letters must be submitted
electronically on IEEE’s on-line manuscript submission and peer-
review system, ScholarOne® Manuscripts, at
mc.manuscriptcentral.com/maglet-ieee. First check if you have an
existing account. If there is none, please create a new account. (If
you already have an account for IEEE Transactions on Magnetics,
it will be available to you for Magnetics Letters.) After logging in,
go to your Author Center and click “Submit First Draft of a New
Manuscript.”
Along with other information, you will be asked to select the

subject from a pull-down list. There are 7 steps to the submission
process; you must complete all 7 for a complete submission. At
the end of each step you must click “Save and Continue”; just

http://www.ieee.org/publications_standards/publications/authors/author_templates.html
http://www.ieee.org/publications_standards/publications/authors/auth_names_native_lang.pdf
http://mc.manuscriptcentral.com/maglet-ieee
http://www.ieee.org/publications_standards/publications/authors/author_templates.html
http://www.ieee.org/publications_standards/publications/authors/author_templates.html
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uploading the paper is not sufficient. After step 7 you should see a
confirmation that the submission is complete. You should also
receive an e-mail confirmation. For inquiries regarding the
submission of your paper on ScholarOne® Manuscripts, please
contact oprs-support@ieee.org or call +1 732 465 5861.
ScholarOne® Manuscripts will accept files for review in the

following formats: DOC, DOCX, RTF, PS, or PDF. PDF is
preferred at the review stage. If you used LaTeX to prepare your
document, you must generate a PDF or PS file to upload to
ScholarOne® Manuscripts. Whatever format you upload, your
figures should be embedded in the file, usually at the end.
You will be asked to file an electronic copyright form during

the submission process. (Authors are responsible for obtaining any
security clearances.) You will also have the opportunity to
designate your article as “open access” in perpetuity if you agree
to pay the IEEE open access fee.

B. Final Submission

After your paper is accepted, you will be asked to upload final
files to ScholarOne® Manuscripts. These will include your DOC,
DOCX, RTF, or LaTeX document source file with embedded
figures; an additional PS or PDF file if your source is LaTeX; and
separate, individual figure files. These individual files may be in
any of the following formats: TIF (preferred), PDF (preferred),
JPG, GIF, EPS, DOC or DOCX (especially good for tables), or
PPT (commonly used to make figures). Please convert your DOC
or DOCX tables and PPT figures to PDF. Figure and table files
should be named following this convention: FIG1.TIF, FIG2.PPT,
FIG3.PDF, etc. See more about figure preparation in Section III
below.
Also upload a file with complete contact information for all

authors. Include full mailing addresses, telephone numbers, fax
numbers, and e-mail addresses. Designate the author who
submitted the manuscript on ScholarOne® Manuscripts as the
“corresponding author.” This is the only author to whom proofs of
the paper will be sent.

C. Publication

When your files are all uploaded and checked by the Magnetics
Letters editorial office, your paper will be sent to IEEE, where it
will be posted as a preprint on IEEE’s Xplore® platform, which
will represent official publication. Thus, your final submitted
manuscript should be a version you would like people to read.
PDF page proofs will be sent by e-mail to the corresponding
author in 4 to 6 weeks. The typeset article, with its article number,
should appear on Xplore® a few days after the author approves the
proofs.

XXI. ADVANCED INFORMATION ON CREATION
OF ELECTRONIC IMAGE FILES

Most authors will be able to prepare images in one of the
allowed formats listed above. This section provides optional,
additional information on preparing PS, EPS, and TIFF files. No
matter how you convert your images, it is a good idea to print the
files to make sure nothing was lost in the process.
For more information on graphics files, please go to

www.ieee.org/publications_standards/publications/authors/authors
_journals.html and click on the link “Using Microsoft Products or
PDFs to Submit Graphics.”

A. IEEE Graphics Checker

Graphics Checker is part of the IEEE’s “Author Digital
Toolbox,” a collection of tools for authors at
www.ieee.org/publications_standards/publications/authors/authors
_journals.html. The direct link for Graphics Checker is
graphicsqc.ieee.org. You can upload image files in batches of up
to 10 to be analyzed and compared to IEEE’s requirements for
metadata, file size, file type, file naming, resolution parameters,
and color format. You will receive a detailed report on the
usability of each image analyzed. The report will include an
explanation of any error found, along with, when possible,
application-specific tips on how to fix the image. (You may ignore
warnings that the author’s name is not part of the file name.) For
more Information, contact the IEEE Graphics Help Desk at
graphics@ieee.org. You will receive an e-mail response and
sometimes a request for a sample graphic for IEEE to check.

B. Scanning Images to PS and EPS

If you have a scanner, a quick way to prepare figure files is to
print your figures on paper exactly as you want them to appear,
scan them, and then save them to a file in PostScript (PS) or
Encapsulated PostScript (EPS) formats. Use a separate file for
each image. File names should be of the form FIG1.PS or
FIG2.EPS.

C. Scanning Images to TIFF

Using a scanner as above, you may save the images in TIFF
format. The following specifications are the minimum
requirements for TIFF images; you may use higher resolution. As
a rule, if your image file size is below 500 kB, your TIFF image
probably does not have enough resolution.
High-contrast line figures and tables should be prepared with at

least 600 dpi resolution and saved with no compression, 1 bit per
pixel (monochrome), with file names of the form FIG3.TIF. To
obtain a 3.45 inch figure (one column width) at 600 dpi, the figure
requires a horizontal size of 2070 pixels.
Photographs and grayscale figures should be prepared with at

least 220 dpi resolution and saved with no compression, 8 bits per
pixel (grayscale). To obtain a 3.45 inch figure (one column width)
at 220 dpi, the figure should have a horizontal size of 759 pixels.
Color figures should be prepared with at least 400 dpi resolution

and saved with no compression, 8 bits per pixel (palette or 256
color). To obtain a 3.45 inch figure (one column width) at 400 dpi,
the figure should have a horizontal size of 1380 pixels.

D. Printing Images to PS Files

You may create PostScript figures by “printing” them to files.
First, download a PostScript printer driver from
www.adobe.com/support/downloads/product.jsp?product=pdrv&p
latform=win (for Windows) or
www.adobe.com/support/downloads/product.jsp?product=44&plat
form=Macintosh (for Macintosh) and also install the “PPD Files:

http://www.ieee.org/publications_standards/publications/authors/authors_journals.html
http://www.ieee.org/publications_standards/publications/authors/authors_journals.html
http://www.ieee.org/publications_standards/publications/authors/authors_journals.html
http://www.ieee.org/publications_standards/publications/authors/authors_journals.html
http://graphicsqc.ieee.org/
http://www.adobe.com/support/downloads/product.jsp?product=pdrv&platform=win
http://www.adobe.com/support/downloads/product.jsp?product=pdrv&platform=win
http://www.adobe.com/support/downloads/product.jsp?product=44&platform=Macintosh
http://www.adobe.com/support/downloads/product.jsp?product=44&platform=Macintosh
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Adobe” printer definition. In Word, paste your figure into a new
document. Print to a file using the PostScript printer driver. File
names should be of the form FIG5.PS. Use “Open Type” fonts
when creating your figures, if possible: Times Roman, Helvetica,
Helvetica Narrow, Courier, Symbol, Palatino, Avant Garde,
Bookman, Zapf Chancery, Zapf Dingbats, and New Century
Schoolbook.

E. Converting PDF to TIFF

Experienced computer users can convert figures and tables from
their original format to TIFF. Some useful image converters are
Adobe Photoshop, Corel Draw, Microsoft Photo Editor (part of
Office 97 through Office XP), Picture Manager (Office 2003,
2007, 2010), and Photo Gallery (Office 2013). A free, versatile
program for image manipulation and format conversion is GIMP,
available from www.gimp.org.
From Microsoft Office applications, such as PowerPoint, you

may print or save as PDF. You may then convert a figure in the
PDF file to TIFF with Adobe Acrobat or Reader: View > Zoom to
a large magnification (e.g., 1600%). Use the Snapshot Tool to
select the figure and copy it to the Windows clipboard. Open
Microsoft Photo Editor, Edit > Paste as New Image, crop, and
adjust resolution as above. (If using Picture Manager, use Picture
> Crop, Picture > Resize, File > Export.)
Note that the obvious way to convert PowerPoint PPT to TIFF

(File > Save As > Save as type TIFF) gives poor results.
Alternatively, you may open the PDF in Photoshop or GIMP.

Set the resolution to open at 1200 dpi. In GIMP, use “Export As”
and save in TIFF format with no compression.

F. Saving Files in TIFF

Most graphing programs allow you to save graphs in TIFF;
however, you often have no control over compression or number
of bits per pixel. You should open these image files in a program
such as Microsoft Photo Editor and re-save them using no
compression, either 1 or 8 bits, and either 600 or 220 dpi
resolution (File > Properties; Image > Resize). See Section III.C
for an explanation of number of bits and resolution.

G. Using Print Screen

If your graphing program cannot export to TIFF, you can use
the Print Screen function. Set your monitor to its highest
resolution. Adjust the magnification so that you can view the
entire image on the screen. (In PowerPoint, you may use Slide
Show to get a full-screen image.) Move the cursor so it is out of
the way. Press “Print Screen” on your keyboard; this copies the
screen image to the Windows clipboard. Open Microsoft Photo
Editor and click Edit > Paste as New Image. Crop the image (click
Select button; select the part you want, then Image > Crop).
Adjust the properties of the image (File > Properties) to get a
width of 3.45 inches. Save the file (File > Save As) in TIFF with
no compression (click “More” button). Similar functionality is
available in GIMP and Photoshop.

XXII. UNITS

Use either SI (MKS) or CGS as primary units. (SI units are

strongly encouraged.) English units may be used as secondary
units (in parentheses). This applies to papers in data storage. For
example, write “15 Gbit/cm2 (100 Gbit/in2).” An exception is
when English units are used as identifiers in trade, such as “3½ in
disk drive.” Avoid combining SI and CGS units, such as current in
amperes and magnetic field in oersteds. This often leads to
confusion because equations do not balance dimensionally. If you
must use mixed units, clearly state the units for each quantity in an
equation.
The SI unit for magnetic field strength H is A/m. However, if

you wish to use units of T, either refer to magnetic flux density B
or magnetic field strength symbolized as µ0H. Use the center dot
to separate compound units, e.g., “A·m2.”

XXIII. HELPFUL HINTS

A. Editing Service

IEEE has partnered with SPi Publisher Services to offer pre-
submission professional editing services to IEEE authors. SPi
copyedits and typesets more than 1 million pages per year for over
600 journals. Authors who would like assistance with English
grammar and usage prior to submitting their manuscripts for
review or during the review process can go to www.prof-
editing.com/ieee to submit a manuscript for copyediting. A link is
provided on the Manuscript Central Web site. SPi copyeditors will
edit for grammar, usage, organization, and clarity. Authors can use
the service, at their own expense, as often as desired. Cost
estimates are available on-line, typically about $100 for a four-
page article. Edited manuscripts are generally returned to the
authors within two weeks of submission.

B. Figures and Tables

Because IEEE will do the final formatting of your paper, you do
not need to position figures and tables at the tops and bottoms of
columns. In fact, all figures, figure captions, and tables can be at
the end of the paper. Please mark in the text where the figures and
tables are supposed to appear. Large figures and tables may span
both columns. Place figure captions below the figures; place table
captions above the tables. If your figure has two parts, for example,
include the labels “(a)” and “(b)” as part of the artwork. Please
verify that figures and tables that you mention in the text actually
exist. Please do not include captions as part of the figures. Do not
put captions in “text boxes” linked to the figures. Do not put
borders around the outside of your figures. Use the abbreviation
“Fig.” even at the beginning of a sentence. Do not abbreviate
“Table.” Tables are numbered with Arabic numerals.

TABLE 1 HERE

C. Color Figures

There is no charge for color figures. Since a black-and-white
print compilation of Magnetics Letters is published annually,
please be certain that your figures are generally understandable
without the color information.
Figure axis labels are often a source of confusion. Use words

rather than symbols. As an example, write the quantity

http://www.gimp.org
http://www.prof-editing.com/ieee/
http://www.prof-editing.com/ieee/
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“Magnetization,” or “Magnetization, M,” not just “M.” However,
if there is not enough room on the axis to specify the quantity,
write just the symbol “M,” but define it in the figure caption.
IEEE allows two ways to designate units in graphs and tables:

(1) Put units in parentheses. As in Fig. 1, for example, write
“Magnetization (A/m)” or “Magnetization, M (A m  1)” (but not
just “A/m”). (2) Label axes with a ratio of symbols and units. For
example, write “Magnetization, M/(A  m  1)” or “Temperature,
T/K” (but not “Temperature/K”).
Multipliers can be especially confusing. Write “Magnetization

(kA/m)” or “Magnetization (103 A/m).” Do not write
“Magnetization (A/m)  1000” because the reader would not know
whether the top axis label in Fig. 1 meant 16000 A/m or 0.016
A/m. Figure labels should be legible, approximately 8 to 10 point
type when reduced to journal column width.

FIG. 1 HERE

D. References

Magnetics Letters uses an unnumbered reference style, different
from most other IEEE journals. Cite articles by first author and
year in square brackets [Eason 1955]. The sentence punctuation
follows the brackets. Multiple references are combined within
brackets [Eason 1955, Maxwell 1892]. When citing a section in a
book, please give the relevant page numbers [Maxwell 1892]. If
the reference is part of the sentence, refer to the authors with the
year in brackets, as shown by Eason et al. [1955] and Jacobs and
Bean [1963]. Unfortunately the IEEE document translator cannot
handle automatic endnotes in Word; therefore, type the reference
list at the end of the paper using the “References” style. For
journal articles, please include the Digital Object Identifier if you
can find it at www.crossref.org/guestquery.
In the reference list, give all authors’ names; do not use “et al.”

Use a space after authors’ initials. Papers that have not been
published should be cited as “unpublished” [Gilbert 1956]. Papers
that have been submitted for publication should be cited as
“submitted for publication” [Arnold 2016]. (Since the paper may
not be accepted, it is best to not specify the journal.) Papers that
have been accepted for publication but not yet assigned to an issue
should be cited as “to be published” [Demokritov 2016]. Please
give affiliations and addresses for private communications
[Kaufman 2004].
Capitalize only the first word in a paper title, except for proper

nouns and element symbols. For papers published in translation
journals, please give the English citation first, followed by the
original foreign-language citation [Yorozu 1987].
Adequacy of references is one of the many factors considered

by the reviewers. However, you should not include gratuitous or
irrelevant references to Magnetics Letters. Do not excessively cite
your own prior publications.
Number footnotes separately in superscripts (References >

Insert Footnote). Place the actual footnote at the bottom of the
column in which it is cited; do not put footnotes in the reference

list (endnotes). Use letters for table footnotes (see Table 1).4

E. Abbreviations and Acronyms

Define abbreviations and acronyms the first time they are used
in the text, even after they have already been defined in the
abstract. Abbreviations such as “IEEE,” “SI,” “ac,” and “dc” do
not have to be defined. Abbreviations that incorporate periods
should not have spaces: write “C.N.R.S.,” not “C. N. R. S.” Do
not use abbreviations in the title unless they are unavoidable (for
example, “IEEE” in the title of this article).

F. Equations

If you are using Word, use either the Microsoft Equation Editor
or the MathType add-on (www.dessci.com/en/products/mathtype)
for equations in your paper (Insert > Equation). Fit the equation
into one column by breaking it as you wish it to appear when
typeset. You may find it convenient to create a new “equation” for
each section of the equation.
Number equations consecutively with equation numbers in

parentheses in the vicinity of the equation, as in (1). To make your
equations more compact, you may use the solidus ( / ), the exp
function, or appropriate exponents. Use parentheses to avoid
ambiguities in denominators. Punctuate equations when they are
part of a sentence, as in

(1)

The font for symbols should be similar to Times Roman. Use
the “Symbol” style. Be sure that the symbols in your equation
have been defined either before the equation appears or
immediately following. Italicize symbols (T might refer to
temperature, but T is the unit tesla). Refer to “(1),” not “Eq. (1)”
or “equation (1),” except at the beginning of a sentence: “Equation
(1) is ... .”
Please confine equations to one column width and break

equations at appropriate algebraic symbols.

G. Other Recommendations

Use one space after periods and colons. Hyphenate complex
modifiers: “zero-field-cooled magnetization.” However, do not
hyphenate numbers and units: “10 nm thick film,” not “10-nm-
thick film.” Avoid dangling participles, such as, “Using (1), the
potential was calculated.” [It is not clear who or what used (1).]
Write instead, “The potential was calculated by using (1),” or
“Using (1), we calculated the potential.”
Use a zero before decimal points: “0.25,” not “.25.” Use “cm3,”

not “cc.” Indicate sample dimensions as “0.1 cm  0.2 cm,” not
“0.1  0.2 cm2.” The abbreviation for “seconds” is “s,” not “sec.”
Do not mix complete spellings and abbreviations of units: use
“Wb/m2” or “webers per square meter,” not “webers/m2.” When

4 Try to avoid footnotes (except for the unnumbered footnote with the e-mail address
of the corresponding author on the first page). Instead, try to integrate the footnote
information into the text.

http://www.crossref.org/guestquery
http://www.dessci.com/en/products/mathtype
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expressing a range of values, write “7 to 9” or “7–9,” not “7~9.”
A parenthetical statement at the end of a sentence is punctuated

outside of the closing parenthesis (like this). (A parenthetical
sentence is punctuated within the parentheses.) In American
English, periods and commas are within quotation marks, like
“this period.” Other punctuation is “outside”! Avoid contractions;
for example, write “do not” instead of “don’t.” The serial comma
is preferred: “A, B, and C” instead of “A, B and C.”
If you wish, you may write in the first person singular or plural

(use the singular if you are the only author) and use the active
voice (“I observed that ...” or “We observed that ...” instead of “It
was observed that ...”). Better still, omit statements of observation
and just report what you measured: “The susceptibility decreased
with temperature” instead of “We observed that the susceptibility
decreased with temperature.” Similarly, avoid “We found that
… .”
Remember to check spelling. If you are not fluent in English,

please get a colleague to proofread your paper.

XXIV. SOME COMMON MISTAKES

The word “data” is plural, not singular. The subscript for the
permeability of vacuum 0 is zero, not a lowercase letter “o.” The
term for residual magnetization is “remanence”; the adjective is
“remanent”; do not write “remnance” or “remnant.” Use the word
“micrometer” instead of “micron.” A graph within a graph is an
“inset,” not an “insert.” The word “alternatively” is preferred to
the word “alternately” (unless you really mean something that
alternates). Use the word “whereas” instead of “while” (unless you
are referring to simultaneous events). Do not use the word
“essentially” to mean “approximately” or “effectively.” Do not use
the word “issue” as a euphemism for “problem.”
Because “times” refers to multiplication, do not use the form “n

times smaller”; instead, write “1/n times as large” or similar. For
example, instead of “10 times smaller,” write “one tenth the size”
or “0.1 times as large.” Do not use “times more”; instead, write
“times as much.” For example, “2 times more” could be
interpreted as “3 times as much.”
When compositions are not specified, separate chemical

symbols by hyphens; for example, “NiMn” indicates the
intermetallic compound Ni0.5Mn0.5 whereas “Ni-Mn” indicates an
alloy of some composition NixMn1-x.
Be aware of the different meanings of the homophones “affect”

(usually a verb) and “effect” (usually a noun), “complement” and
“compliment,” “discreet” and “discrete,” “principal” (e.g.,
“principal investigator”) and “principle” (e.g., “principle of
measurement”). Do not confuse “imply” and “infer.”
Prefixes such as “non,” “sub,” “micro,” and “ultra” are not

independent words; they should be joined to the words they
modify, usually without a hyphen. There is no period after the “et”
in the Latin abbreviation “et al.” The abbreviation “i.e.” means
“that is,” and the abbreviation “e.g.” means “for example.”
An excellent style manual and source of information for science

writers is Young [1989]. A general IEEE style guide, Information
for Authors, is available at
www.ieee.org/publications_standards/publications/authors/authors

_journals.html. (The style for Magnetics Letters differs in many
respects.)

XXV. EDITORIAL POLICY

Do not submit a reworked version of a paper you have
submitted or published elsewhere, including conference papers.
Do not submit “preliminary” data or results. The submitting author
is responsible for obtaining agreement of all coauthors and any
consent required from sponsors before submitting a paper.
Magnetics Letters strongly discourages courtesy authorship.
It is the obligation of the authors to cite relevant prior work. If

you copy sentences, paragraphs, figures, or tables from another
paper, even if it is your own paper, you must cite that paper at the
corresponding point in your manuscript. IEEE’s plagiarism (and
excessive duplication) guidelines are described in detail at. All
articles submitted for review are screened for plagiarism.
At least two favorable reviews are required for a paper to be

accepted for publication. In the event of an unfavorable review, it
is at the discretion of the editor whether to seek additional reviews.
The editors additionally make a determination of suitability, which
is different from a judgment of whether a paper is sound or flawed.
The editors consider whether a paper contributes significant new
material, is within the scope of the journal, or is more suited to
another journal. Undecipherable English is a valid reason for
rejection.

XXVI. PUBLICATION PRINCIPLES

Magnetics Letters is a rapid-publication, primarily electronic,
peer-reviewed, archival journal dedicated exclusively to magnetics
articles of substantial current interest.
Authors should consider the following points:
1. Technical papers submitted for publication must advance the

state of knowledge and must cite relevant prior work.
2. Authors must convince both peer reviewers and the editors of

the scientific and technical merit of a paper; the standards of proof
are higher when extraordinary or unexpected results are reported.
3. Because replication is required for scientific progress, papers

submitted for publication must provide sufficient information to
allow readers to perform similar experiments or calculations and
use the reported results. Although not everything need be
disclosed, a paper must contain new, useable, and fully described
information. For example, a specimen’s chemical composition
need not be reported if the main purpose of a paper is to introduce
a new measurement technique. Authors should expect to be
challenged by reviewers if the results are not supported by
adequate data and critical details.
4. Papers that describe ongoing work or announce the latest

technical achievement, which are suitable for presentation at a
professional conference, may not be appropriate for publication in
Magnetics Letters.

XXVII. CONCLUSION

A conclusion section is not required. Although a conclusion
may review the main points of the paper, do not replicate the

http://www.ieee.org/publications_standards/publications/authors/authors_journals.html
http://www.ieee.org/publications_standards/publications/authors/authors_journals.html
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abstract in the conclusion. A conclusion might elaborate on the
importance of the work or suggest applications and extensions.
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Fig. 1. Magnetization as a function of applied field. Note that “Fig.”
is abbreviated. It is good practice to explain the significance of the
figure in the caption.

Table 1. Units for magnetic properties (table caption).

Symbol Quantity a Conversion from Gaussian
and cgs emu to SI b

 magnetic flux 1 Mx 108 Wb = 108 V·s
B magnetic flux density,

magnetic induction
1 G 104 T = 104 Wb/m2

H magnetic field strength 1 Oe 103/(4) A/m
m magnetic moment 1 erg/G = 1 emu

 103 A·m2 = 103 J/T
M magnetization 1 erg/(G·cm3) = 1 emu/cm3

 103 A/m
4M magnetization 1 G 103/(4) A/m
 specific magnetization 1 erg/(G·g) = 1 emu/g

 1 A·m2/kg
j magnetic dipole

moment
1 erg/G = 1 emu
 4  1010 Wb·m

J magnetic polarization 1 erg/(G·cm3) = 1 emu/cm3

 4  104 T
,  susceptibility 1 4
 specific susceptibility 1 cm3/g 4  103 m3/kg
 permeability 1 4  107 H/m

= 4  107 Wb/(A·m)
r relative permeability   r
w, W energy density 1 erg/cm3  101 J/m3

N, D demagnetizing factor 1 1/(4)
a No vertical lines in table.
b Gaussian units are the same as cgs emu for magnetostatics; Mx =
maxwell, G = gauss, Oe = oersted; Wb = weber, V = volt, s = second,
T = tesla, m = meter, A = ampere, J = joule, kg = kilogram, H = henry.

http://www.crossref.org/guestquery
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Abstract—These instructions give you guidelines for preparing
papers for IEEE Transactions and Journals. Use this document
as a template if you are using Microsoft Word 6.0 or later.
Otherwise, use this document as an instruction set. The
electronic file of your paper will be formatted further at IEEE.
Paper titles should be written in uppercase and lowercase
letters, not all uppercase. Avoid writing long formulas with
subscripts in the title; short formulas that identify the elements
are fine (e.g., "Nd–Fe–B"). Do not write “(Invited)” in the title.
Full names of authors are preferred in the author field, but are
not required. Put a space between authors’ initials. Define all
symbols used in the abstract. Do not cite references in the
abstract. Do not delete the blank line immediately above the
abstract; it sets the footnote at the bottom of this column.

Index Terms—Enter key words or phrases in alphabetical
order, separated by commas. For a list of suggested keywords,

This paragraph of the first footnote will contain the date on which you
submitted your paper for review. It will also contain support information,
including sponsor and financial support acknowledgment. For example,
“This work was supported in part by the U.S. Department of Commerce
under Grant BS123456”.

The next few paragraphs should contain the authors’ current affiliations,
including current address and e-mail. For example, F. A. Author is with
the National Institute of Standards and Technology, Boulder, CO 80305
USA (e-mail: author@ boulder.nist.gov).

S. B. Author, Jr., was with Rice University, Houston, TX 77005 USA.
He is now with the Department of Physics, Colorado State University, Fort
Collins, CO 80523 USA (e-mail: author@lamar.colostate.edu).

T. C. Author is with the Electrical Engineering Department, University
of Colorado, Boulder, CO 80309 USA, on leave from the National
Research Institute for Metals, Tsukuba, Japan (e-mail: author@nrim.go.jp).
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send a blank e-mail to keywords@ieee.org or visit
http://www.ieee.org/organizations/pubs/ani_prod/keywrd98.txt

1. INTRODUCTION

HIS document is a template for Microsoft Word versions 6.0 or
later. If you are reading a paper or PDF version of this document,
please download the electronic file,

TRANS-JOUR.DOC, from the IEEE Web site at
http://www.ieee.org/web/publications/authors/transjnl/index.html so
you can use it to prepare your manuscript. If you would prefer to
use LATEX, download IEEE’s LATEX style and sample files from
the same Web page. Use these LATEX files for formatting, but
please follow the instructions in TRANS-JOUR.DOC or TRANS-
JOUR.PDF.

If your paper is intended for a conference, please contact your
conference editor concerning acceptable word processor formats
for your particular conference.

2. GUIDELINES FOR MANUSCRIPT PREPARATION

When you open TRANS-JOUR.DOC, select “Page Layout” from
the “View” menu in the menu bar (View | Page Layout), (these
instructions assume MS 6.0. Some versions may have alternate
ways to access the same functionalities noted here). Then, type
over sections of TRANS-JOUR.DOC or cut and paste from another
document and use markup styles. The pull-down style menu is at
the left of the Formatting Toolbar at the top of your Word window
(for example, the style at this point in the document is “Text”).

Highlight a section that you want to designate with a certain
style, then select the appropriate name on the style menu. The
style will adjust your fonts and line spacing. Do not change the
font sizes or line spacing to squeeze more text into a limited
number of pages. Use italics for emphasis; do not underline.
To insert images inWord, position the cursor at the insertion
point and either use Insert | Picture | From File or copy the image
to the Windows clipboard and then Edit | Paste Special | Picture
(with “float over text” unchecked).
IEEE will do the final formatting of your paper. If your paper is
intended for a conference, please observe the conference page
limits.

a. Abbreviations and Acronyms

Define abbreviations and acronyms the first time they are used in
the text, even after they have already been defined in the abstract.
Abbreviations such as IEEE, SI, ac, and dc do not have to be
defined. Abbreviations that incorporate periods should not have
spaces: write “C.N.R.S.,” not “C. N. R. S.” Do not use abbreviations
in the title unless they are unavoidable (for example, “IEEE” in the
title of this article).

b. Other Recommendations

Use one space after periods and colons. Hyphenate complex
modifiers: “zero-field-cooled magnetization.” Avoid dangling
participles, such as, “Using (1), the potential was calculated.” [It is
not clear who or what used (1).] Write instead, “The potential was
calculated by using (1),” or “Using (1), we calculated the potential.”

Use a zero before decimal points: “0.25,” not “.25.” Use “cm3,”
not “cc.” Indicate sample dimensions as “0.1 cm  0.2 cm,” not “0.1
 0.2 cm2.” The abbreviation for “seconds” is “s,” not “sec.” Use
“Wb/m2” or “webers per square meter,” not “webers/m2.” When
expressing a range of values, write “7 to 9” or “7-9,” not “7~9.”

A parenthetical statement at the end of a sentence is punctuated
outside of the closing parenthesis (like this). (A parenthetical
sentence is punctuated within the parentheses.) In American
English, periods and commas are within quotation marks, like “this
period.” Other punctuation is “outside”! Avoid contractions; for

example, write “do not” instead of “don’t.” The serial comma is
preferred: “A, B, and C” instead of “A, B and C.”

If you wish, you may write in the first person singular or plural
and use the active voice (“I observed that ...” or “We observed
that ...” instead of “It was observed that ...”). Remember to check
spelling. If your native language is not English, please get a native
English-speaking colleague to carefully proofread your paper.

c. How to Create a PostScript File

First, download a PostScript printer driver from
http://www.adobe.com/support/downloads/pdrvwin.htm (for
Windows) or from http://www.adobe.com/support/downloads/
pdrvmac.htm (for Macintosh) and install the “Generic PostScript
Printer” definition. In Word, paste your figure into a new document.
Print to a file using the PostScript printer driver. File names should
be of the form “fig5.ps.” Use Open Type fonts when creating your
figures, if possible. A listing of the acceptable fonts are as follows:
Open Type Fonts: Times Roman, Helvetica, Helvetica Narrow,
Courier, Symbol, Palatino, Avant Garde, Bookman, Zapf Chancery,
Zapf Dingbats, and New Century Schoolbook.

3. MATH

If you are using Word, use either the Microsoft Equation Editor or
the MathType add-on (http://www.mathtype.com) for equations in
your paper (Insert | Object | Create New | Microsoft Equation or
MathType Equation). “Float over text” should not be selected.

a. Equations

Number equations consecutively with equation numbers in
parentheses flush with the right margin, as in (1). First use the
equation editor to create the equation. Then select the “Equation”
markup style. Press the tab key and write the equation number in
parentheses. To make your equations more compact, you may use
the solidus ( / ), the exp function, or appropriate exponents. Use
parentheses to avoid ambiguities in denominators. Punctuate
equations when they are part of a sentence, as in

.)()()||(exp
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Be sure that the symbols in your equation have been defined
before the equation appears or immediately following. Italicize
symbols (T might refer to temperature, but T is the unit tesla). Refer
to “(1),” not “Eq. (1)” or “equation (1),” except at the beginning of a
sentence: “Equation (1) is ... .”

4. UNITS

Use either SI (MKS) or CGS as primary units. (SI units are
strongly encouraged.) English units may be used as secondary
units (in parentheses). This applies to papers in data storage. For
example, write “15 Gb/cm2 (100 Gb/in2).” An exception is when
English units are used as identifiers in trade, such as “3½-in disk
drive.” Avoid combining SI and CGS units, such as current in
amperes and magnetic field in oersteds. This often leads to
confusion because equations do not balance dimensionally. If you
must use mixed units, clearly state the units for each quantity in an
equation.

The SI unit for magnetic field strength H is A/m. However, if you
wish to use units of T, either refer to magnetic flux density B or
magnetic field strength symbolized as µ0H. Use the center dot to
separate compound units, e.g., “A·m2.”

T

mailto:keywords@ieee.org
http://www.ieee.org/organizations/pubs/ani_prod/keywrd98.txt
http://www.ieee.org/web/publications/authors/transjnl/index.html
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5. SOME COMMON MISTAKES

The word “data” is plural, not singular. The subscript for the
permeability of vacuum µ0 is zero, not a lowercase letter “o.” The
term for residual magnetization is “remanence”; the adjective is
“remanent”; do not write “remnance” or “remnant.” Use the word
“micrometer” instead of “micron.” A graph within a graph is an
“inset,” not an “insert.” The word “alternatively” is preferred to the
word “alternately” (unless you really mean something that
alternates). Use the word “whereas” instead of “while” (unless you
are referring to simultaneous events). Do not use the word
“essentially” to mean “approximately” or “effectively.” Do not use the
word “issue” as a euphemism for “problem.” When compositions are
not specified, separate chemical symbols by en-dashes; for
example, “NiMn” indicates the intermetallic compound Ni0.5Mn0.5
whereas “Ni–Mn” indicates an alloy of some composition NixMn1-x.

Be aware of the different meanings of the homophones “affect”
(usually a verb) and “effect” (usually a noun), “complement” and
“compliment,” “discreet” and “discrete,” “principal” (e.g., “principal
investigator”) and “principle” (e.g., “principle of measurement”). Do
not confuse “imply” and “infer.”

Prefixes such as “non,” “sub,” “micro,” “multi,” and “ultra” are not
independent words; they should be joined to the words they modify,
usually without a hyphen. There is no period after the “et” in the
Latin abbreviation “et al.” (it is also italicized). The abbreviation
“i.e.,” means “that is,” and the abbreviation “e.g.,” means “for
example” (these abbreviations are not italicized).

A general IEEE styleguide is available at
http://www.ieee.org/web/publications/authors/transjnl/index.html

6. GUIDELINES FOR GRAPHICS PREPARATION
AND SUBMISSION

a. Types of Graphics

The following list outlines the different types of graphics published
in IEEE journals. They are categorized based on their construction,
and use of color / shades of gray:

i. Color/Grayscale figures

Figures that are meant to appear in color, or shades of
black/gray. Such figures may include photographs,
illustrations, multicolor graphs, and flowcharts.

ii. Lineart figures

Figures that are composed of only black lines and shapes.
These figures should have no shades or half-tones of gray.
Only black and white.

iii. Author photos

Head and shoulders shots of authors which appear at the end
of our papers.

iv. Tables
Data charts which are typically black
and white, but sometimes include
color.

b. Multipart figures

Figures compiled of more than one sub-figure presented side-by-
side, or stacked. If a multipart figure is made up of multiple figure
types (one part is lineart, and another is grayscale or color) the
figure should meet the stricter guidelines.

c. File Formats For Graphics

Format and save your graphics using a suitable graphics
processing program that will allow you to create the images as
PostScript (PS), Encapsulated PostScript (.EPS), Tagged Image
File Format (.TIFF), Portable Document Format (.PDF), or Portable
Network Graphics (.PNG) sizes them, and adjusts the resolution
settings. If you created your source files in one of the following
programs you will be able to submit the graphics without converting
to a PS, EPS, TIFF, PDF, or PNG file: Microsoft Word, Microsoft

TABLE I
UNITS FORMAGNETIC PROPERTIES

Symbol Quantity Conversion from Gaussian and
CGS EMU to SI a

 magnetic flux 1 Mx 108 Wb = 108 V·s
B magnetic flux density,

magnetic induction
1 G 104 T = 104 Wb/m2

H magnetic field strength 1 Oe 103/(4) A/m
m magnetic moment 1 erg/G = 1 emu

 103 A·m2 = 103 J/T
M magnetization 1 erg/(G·cm3) = 1 emu/cm3

 103 A/m
4M magnetization 1 G 103/(4) A/m
 specific magnetization 1 erg/(G·g) = 1 emu/g 1 A·m2/kg
j magnetic dipole

moment
1 erg/G = 1 emu
 4  1010 Wb·m

J magnetic polarization 1 erg/(G·cm3) = 1 emu/cm3

 4  104 T
,  susceptibility 1 4
 mass susceptibility 1 cm3/g 4  103 m3/kg
 permeability 1 4  107 H/m

= 4  107 Wb/(A·m)
r relative permeability   r
w, W energy density 1 erg/cm3  101 J/m3

N, D demagnetizing factor 1 1/(4)

Vertical lines are optional in tables. Statements that serve as captions for
the entire table do not need footnote letters.

aGaussian units are the same as cg emu for magnetostatics; Mx =
maxwell, G = gauss, Oe = oersted; Wb = weber, V = volt, s = second, T =
tesla, m = meter, A = ampere, J = joule, kg = kilogram, H = henry.

Fig. 1. Magnetization as a function of applied field. Note that “Fig.” is
abbreviated. There is a period after the figure number, followed by two
spaces. It is good practice to explain the significance of the figure in the
caption.

http://www.ieee.org/web/publications/authors/transjnl/index.html
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PowerPoint, or Microsoft Excel. Though it is not required, it is
recommended that these files be saved in PDF format rather than
DOC, XLS, or PPT. Doing so will protect your figures from common
font and arrow stroke issues that occur when working on the files
across multiple platforms. When submitting your final paper, your
graphics should all be submitted individually in one of these formats
along with the manuscript.

d. Sizing of Graphics

Most charts, graphs, and tables are one column wide (3.5 inches /
88 millimeters / 21 picas) or page wide (7.16 inches / 181
millimeters / 43 picas). The maximum depth a graphic can be is 8.5
inches (216 millimeters / 54 picas). When choosing the depth of a
graphic, please allow space for a caption. Figures can be sized
between column and page widths if the author chooses, however it
is recommended that figures are not sized less than column width
unless when necessary.

There is currently one publication with column measurements that
don’t coincide with those listed above. PROCEEDINGS OF THE IEEE
has a column measurement of 3.25 inches (82.5 millimeters / 19.5
picas).

The final printed size of author photographs is exactly
1 inch wide by 1.25 inches tall (25.4 millimeters x 31.75 millimeters /
6 picas x 7.5 picas). Author photos printed in editorials measure
1.59 inches wide by 2 inches tall (40 millimeters x 50 millimeters /
9.5 picas x 12 picas).

E. Resolution

The proper resolution of your figures will depend on the type of
figure it is as defined in the “Types of Figures” section. Author
photographs, color, and grayscale figures should be at least 300dpi.
Lineart, including tables should be a minimum of 600dpi.

F. Vector Art

While IEEE does accept, and even recommends that authors
submit artwork in vector format, it is our policy is to rasterize all
figures for publication. This is done in order to preserve the figures’
integrity across multiple computer platforms.

G. Color Space

The term color space refers to the entire sum of colors that can be
represented within the said medium. For our purposes, the three
main color spaces are Grayscale, RGB (red/green/blue) and CMYK
(cyan/magenta/yellow/black). RGB is generally used with on-screen
graphics, whereas CMYK is used for printing purposes.

All color figures should be generated in RGB or CMYK color
space. Grayscale images should be submitted in Grayscale color
space. Line art may be provided in grayscale OR bitmap colorspace.
Note that “bitmap colorspace” and “bitmap file format” are not the
same thing. When bitmap color space is selected, .TIF/.TIFF is the
recommended file format.

h. Accepted Fonts Within Figures

When preparing your graphics IEEE suggests that you use of
one of the following Open Type fonts: Times New Roman, Helvetica,

Arial, Cambria, and Symbol. If you are supplying EPS, PS, or PDF
files all fonts must be embedded. Some fonts may only be native to
your operating system; without the fonts embedded, parts of the
graphic may be distorted or missing.

A safe option when finalizing your figures is to strip out the fonts
before you save the files, creating “outline” type. This converts fonts
to artwork what will appear uniformly on any screen.

i. Using Labels Within Figures

i. Figure Axis labels

Figure axis labels are often a source of confusion. Use words
rather than symbols. As an example, write the quantity
“Magnetization,” or “Magnetization M,” not just “M.” Put units in
parentheses. Do not label axes only with units. As in Fig. 1, for
example, write “Magnetization (A/m)” or “Magnetization (A  m  1),”
not just “A/m.” Do not label axes with a ratio of quantities and units.
For example, write “Temperature (K),” not “Temperature/K.”
Multipliers can be especially confusing. Write “Magnetization

(kA/m)” or “Magnetization (103 A/m).” Do not write “Magnetization
(A/m)  1000” because the reader would not know whether the top
axis label in Fig. 1 meant 16000 A/m or 0.016 A/m. Figure labels
should be legible, approximately 8 to 10 point type.

ii. Subfigure Labels in Multipart Figures
and Tables

Multipart figures should be combined and labeled before final
submission. Labels should appear centered below each subfigure in
8 point Times New Roman font in the format of (a) (b) (c).

j. File Naming

Figures (line artwork or photographs) should be named
starting with the first 5 letters of the author’s last name. The next
characters in the filename should be the number that represents the
sequential location of this image in your article. For example, in
author “Anderson’s” paper, the first three figures would be named
ander1.tif, ander2.tif, and ander3.ps.

Tables should contain only the body of the table (not the
caption) and should be named similarly to figures, except that ‘.t’ is
inserted in-between the author’s name and the table number. For
example, author Anderson’s first three tables would be named
ander.t1.tif, ander.t2.ps, ander.t3.eps.

Author photographs should be named using the first five
characters of the pictured author’s last name. For example, four
author photographs for a paper may be named: oppen.ps, moshc.tif,
chen.eps, and duran.pdf.

If two authors or more have the same last name, their first
initial(s) can be substituted for the fifth, fourth, third... letters of their
surname until the degree where there is differentiation. For example,
two authors Michael and Monica Oppenheimer’s photos would be
named oppmi.tif, and oppmo.eps.
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k. Referencing a Figure or Table Within Your
Paper

When referencing your figures and tables within your paper, use
the abbreviation “Fig.” even at the beginning of a sentence. Do not
abbreviate “Table.” Tables should be numbered with Roman
Numerals.

l. Checking Your Figures: The IEEE Graphics
Checker

The IEEE Graphics Checker Tool enables authors to pre-screen
their graphics for compliance with IEEE Transactions and Journals
standards before submission. The online tool, located at
http://graphicsqc.ieee.org/, allows authors to upload their graphics
in order to check that each file is the correct file format, resolution,
size and colorspace; that no fonts are missing or corrupt; that
figures are not compiled in layers or have transparency, and that
they are named according to the IEEE Transactions and Journals
naming convention. At the end of this automated process, authors
are provided with a detailed report on each graphic within the web
applet, as well as by email.

For more information on using the Graphics Checker Tool
or any other graphics related topic, contact the IEEE Graphics Help
Desk by e-mail at graphics@ieee.org.

m. Submitting Your Graphics

Because IEEE will do the final formatting of your paper,
you do not need to position figures and tables at the top and bottom
of each column. In fact, all figures, figure captions, and tables can
be placed at the end of your paper. In addition to, or even in lieu of
submitting figures within your final manuscript, figures should be
submitted individually, separate from the manuscript in one of the
file formats listed above in section VI-J. Place figure captions below
the figures; place table titles above the tables. Please do not include
captions as part of the figures, or put them in “text boxes” linked to
the figures. Also, do not place borders around the outside of your
figures.

n. Color Processing / Printing in IEEE Journals

All IEEE Transactions, Journals, and Letters allow an author to
publish color figures on IEEE Xplore® at no charge, and
automatically convert them to grayscale for print versions. In most
journals, figures and tables may alternatively be printed in color if an
author chooses to do so. Please note that this service comes at an
extra expense to the author. If you intend to have print color
graphics, include a note with your final paper indicating which
figures or tables you would like to be handled that way, and stating
that you are willing to pay the additional fee.

7. CONCLUSION

A conclusion section is not required. Although a conclusion may
review the main points of the paper, do not replicate the abstract as
the conclusion. A conclusion might elaborate on the importance of
the work or suggest applications and extensions.

APPENDIX
Appendixes, if needed, appear before the acknowledgment.

ACKNOWLEDGMENT

The preferred spelling of the word “acknowledgment” in
American English is without an “e” after the “g.” Use the singular
heading even if you have many acknowledgments. Avoid
expressions such as “One of us (S.B.A.) would like to thank ... .”
Instead, write “F. A. Author thanks ... .” In most cases, sponsor and
financial support acknowledgments are placed in the unnumbered
footnote on the first page, not here.

REFERENCES AND FOOTNOTES

A. References

References need not be cited in text. When they are, number
citations on the line, in square brackets inside the punctuation.
Multiple references are each numbered with separate brackets.
When citing a section in a book, please give the relevant page
numbers. In text, refer simply to the reference number. Do not use
“Ref.” or “reference” except at the beginning of a sentence:
“Reference [3] shows ... .” Please do not use automatic endnotes in
Word, rather, type the reference list at the end of the paper using
the “References” style.
Reference numbers are set flush left and form a column of their

own, hanging out beyond the body of the reference. The reference
numbers are on the line, enclosed in square brackets. In all
references, the given name of the author or editor is abbreviated to
the initial only and precedes the last name. Use them all; use et al.
only if names are not given. Use commas around Jr., Sr., and III in
names. Abbreviate conference titles. When citing IEEE
transactions, provide the issue number, page range, volume
number, year, and/or month if available. When referencing a patent,
provide the day and the month of issue, or application. References
may not include all information; please obtain and include relevant
information. Do not combine references. There must be only one
reference with each number. If there is a URL included with the print
reference, it can be included at the end of the reference.
Other than books, capitalize only the first word in a paper title,

except for proper nouns and element symbols. For papers
published in translation journals, please give the English citation
first, followed by the original foreign-language citation See the end
of this document for formats and examples of common references.
For a complete discussion of references and their formats, see “The
IEEE Style Manual,” available as a PDF link off the Author Digital
Toolbox main page.

a. Footnotes

Number footnotes separately in superscripts (Insert | Footnote).5
Place the actual footnote at the bottom of the column in which it is
cited; do not put footnotes in the reference list (endnotes). Use
letters for table footnotes (see Table I).

5It is recommended that footnotes be avoided (except for the
unnumbered footnote with the receipt date on the first page). Instead, try to
integrate the footnote information into the text.

http://graphicsqc.ieee.org/
mailto:graphics@ieee.org
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8. SUBMITTING YOUR PAPER FOR REVIEW

a. Review Stage Using Word 6.0 or Higher

If you want to submit your file with one column electronically,
please do the following:

--First, click on the View menu and choose Print Layout.
--Second, place your cursor in the first paragraph. Go to

the Format menu, choose Columns, choose one column Layout,
and choose “apply to whole document” from the dropdown menu.

--Third, click and drag the right margin bar to just over 4
inches in width.

The graphics will stay in the “second” column, but you can drag
them to the first column. Make the graphic wider to push out any
text that may try to fill in next to the graphic.

b. Final Stage Using Word 6.0

When you submit your final version (after your paper has been
accepted), print it in two-column format, including figures and tables.
You must also send your final manuscript on a disk, via e-mail, or
through a Web manuscript submission system as directed by the
society contact. You may use Zip for large files, or compress files
using Compress, Pkzip, Stuffit, or Gzip.

Also, send a sheet of paper or PDF with complete contact
information for all authors. Include full mailing addresses, telephone
numbers, fax numbers, and e-mail addresses. This information will
be used to send each author a complimentary copy of the journal in
which the paper appears. In addition, designate one author as the
“corresponding author.” This is the author to whom proofs of the
paper will be sent. Proofs are sent to the corresponding author only.

c. Review Stage Using ScholarOne® Manuscripts

Contributions to the Transactions, Journals, and Letters may
be submitted electronically on IEEE’s on-line manuscript
submission and peer-review system, ScholarOne® Manuscripts.
You can get a listing of the publications that participate in
ScholarOne at
http://www.ieee.org/publications_standards/publications/authors/aut
hors_submission.html First check if you have an existing account. If
there is none, please create a new account. After logging in, go to
your Author Center and click “Submit First Draft of a New
Manuscript.”

Along with other information, you will be asked to select the
subject from a pull-down list. Depending on the journal, there are
various steps to the submission process; you must complete all
steps for a complete submission. At the end of each step you must
click “Save and Continue”; just uploading the paper is not sufficient.
After the last step, you should see a confirmation that the
submission is complete. You should also receive an e-mail
confirmation. For inquiries regarding the submission of your paper
on ScholarOne Manuscripts, please contact oprs-support@ieee.org
or call +1 732 465 5861.

ScholarOne Manuscripts will accept files for review in various
formats. Please check the guidelines of the specific journal for
which you plan to submit.

You will be asked to file an electronic copyright form
immediately upon completing the submission process (authors are
responsible for obtaining any security clearances). Failure to submit
the electronic copyright could result in publishing delays later. You
will also have the opportunity to designate your article as “open
access” if you agree to pay the IEEE open access fee.

d. Final Stage Using ScholarOne Manuscripts

Upon acceptance, you will receive an email with specific
instructions regarding the submission of your final files. To avoid
any delays in publication, please be sure to follow these instructions.
Most journals require that final submissions be uploaded through
ScholarOne Manuscripts, although some may still accept final
submissions via email. Final submissions should include source
files of your accepted manuscript, high quality graphic files, and a
formatted pdf file. If you have any questions regarding the final
submission process, please contact the administrative contact for
the journal.

In addition to this, upload a file with complete contact
information for all authors. Include full mailing addresses, telephone
numbers, fax numbers, and e-mail addresses. Designate the author
who submitted the manuscript on ScholarOne Manuscripts as the
“corresponding author.” This is the only author to whom proofs of
the paper will be sent.

e. Copyright Form

An IEEE copyright form should accompany your final submission.
You can get a .pdf, .html, or .doc version at
http://www.ieee.org/copyright. Authors are responsible for obtaining
any security clearances.

9. EDITORIAL POLICY

Submission of a manuscript is not required for participation in a
conference. Do not submit a reworked version of a paper you have
submitted or published elsewhere. Do not publish “preliminary” data
or results. The submitting author is responsible for obtaining
agreement of all coauthors and any consent required from sponsors
before submitting a paper. The IEEE Transactions and Journals
Department strongly discourages courtesy authorship. It is the
obligation of the authors to cite relevant prior work.

The IEEE Transactions and Journals Department does not
publish conference records or proceedings. The department does
publish papers related to conferences that have been
recommended for publication on the basis of peer review. As a
matter of convenience and service to the technical community,
these topical papers are typically collected and published in one
special issue of most transactions publications.

At least two reviews are required for every paper submitted. For
conference-related papers, the decision to accept or reject a paper
is made by the conference editors and publications committee; the
recommendations of the referees are advisory only. Indecipherable
English is a valid reason for rejection. There is a service available
that will help you improve your English for a fee, and the link to that
service can be found at
http://www.ieee.org/web/publications/authors/transjnl/index.html.
Authors of rejected papers may revise and resubmit them as regular
papers, whereupon they will be reviewed by two new referees.

10. PUBLICATION PRINCIPLES

The two types of contents of that are published are; 1) peer-
reviewed and 2) archival. The Transactions and Journals
Department publishes scholarly articles of archival value as well as
tutorial expositions and critical reviews of classical subjects and
topics of current interest.

Authors should consider the following points:
6) Technical papers submitted for publication must advance the

state of knowledge and must cite relevant prior work.

http://www.ieee.org/publications_standards/publications/authors/authors_submission.html
http://www.ieee.org/publications_standards/publications/authors/authors_submission.html
http://www.ieee.org/copyright
http://www.ieee.org/web/publications/authors/transjnl/index.html
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7) The length of a submitted paper should be commensurate with
the importance, or appropriate to the complexity, of the work.
For example, an obvious extension of previously published
work might not be appropriate for publication or might be
adequately treated in just a few pages.

8) Authors must convince both peer reviewers and the editors of
the scientific and technical merit of a paper; the standards of
proof are higher when extraordinary or unexpected results are
reported.

9) Because replication is required for scientific progress, papers
submitted for publication must provide sufficient information to
allow readers to perform similar experiments or calculations
and use the reported results. Although not everything need be
disclosed, a paper must contain new, useable, and fully
described information. For example, a specimen’s chemical
composition need not be reported if the main purpose of a
paper is to introduce a new measurement technique. Authors
should expect to be challenged by reviewers if the results are
not supported by adequate data and critical details.

10) Papers that describe ongoing work or announce the latest
technical achievement, which are suitable for presentation at a
professional conference, may not be appropriate for
publication.

REFERENCES
Basic format for books:

J. K. Author, “Title of chapter in the book,” in Title of His Published
Book, xth ed. City of Publisher, Country if not

USA: Abbrev. of Publisher, year, ch. x, sec. x, pp. xxx–xxx.
Examples:

G. O. Young, “Synthetic structure of industrial plastics,” in Plastics,
2nd ed., vol. 3, J. Peters, Ed. New York: McGraw-Hill,
1964, pp. 15–64.

W.-K. Chen, Linear Networks and Systems. Belmont, CA:
Wadsworth, 1993, pp. 123–135.

Basic format for periodicals:

J. K. Author, “Name of paper,” Abbrev. Title of Periodical, vol. x, no.
x, pp. xxx-xxx, Abbrev. Month, year.

Examples:

J. U. Duncombe, “Infrared navigation—Part I: An assessment
of feasibility,” IEEE Trans. Electron Devices, vol. ED-11, no. 1,
pp. 34–39, Jan. 1959.

E. P. Wigner, “Theory of traveling-wave optical laser,” Phys. Rev.,
vol. 134, pp. A635–A646, Dec. 1965.

E. H. Miller, “A note on reflector arrays,” IEEE Trans. Antennas
Propagat., to be published.

Basic format for reports:

J. K. Author, “Title of report,” Abbrev. Name of Co., City of Co.,
Abbrev. State, Rep. xxx, year.

Examples:

E. E. Reber, R. L. Michell, and C. J. Carter, “Oxygen absorption in
the earth’s atmosphere,” Aerospace Corp., Los Angeles, CA,
Tech. Rep. TR-0200 (4230-46)-3, Nov. 1988.

J. H. Davis and J. R. Cogdell, “Calibration program for the 16-foot
antenna,” Elect. Eng. Res. Lab., Univ. Texas, Austin, Tech.
Memo. NGL-006-69-3, Nov. 15, 1987.

Basic format for handbooks:

Name of Manual/Handbook, x ed., Abbrev. Name of Co., City of Co.,
Abbrev. State, year, pp. xxx-xxx.

Examples:

Transmission Systems for Communications, 3rd ed., Western
Electric Co., Winston-Salem, NC, 1985, pp. 44–60.

Motorola Semiconductor Data Manual, Motorola Semiconductor
Products Inc., Phoenix, AZ, 1989.

Basic format for books (when available online):

Author. (year, month day). Title. (edition) [Type of medium].
volume (issue). Available: site/path/file

Example:

J. Jones. (1991, May 10). Networks. (2nd ed.) [Online]. Available:
http://www.atm.com

Basic format for journals (when available online):

Author. (year, month). Title. Journal. [Type of medium]. volume
(issue), pages. Available: site/path/file

Example:

R. J. Vidmar. (1992, Aug.). On the use of atmospheric plasmas
as electromagnetic reflectors. IEEE Trans. Plasma Sci.
[Online]. 21(3), pp. 876–880. Available:
http://www.halcyon.com/pub/journals/21ps03-vidmar

Basic format for papers presented at conferences (when available
online):

Author. (year, month). Title. Presented at Conference title.
[Type of Medium]. Available: site/path/file

Example:

PROCESS Corp., MA. Intranets: Internet technologies
deployed behind the firewall for corporate productivity.
Presented at
INET96 Annual Meeting. [Online]. Available:
http://home.process.com/Intranets/wp2.htp

Basic format for reports and handbooks (when available online):

Author. (year, month). Title. Comp an y . C ity , Sta te or
Country. [Type of Medium].Available: site/path/file

Example:

S . L . Ta l l ee n . ( 199 6 , Ap r . ) . Th e I n t r an e t A r ch i -
tec tu r e : M a nag i ng i n f o rm a t i on i n t h e ne w
paradigm. Amdahl Corp., CA. [Online]. Available:
http://www.amdahl.com/doc/products/bsg/intra/infra/html

Basic format for computer programs and electronic documents (when
available online): ISO recommends that capitalization follow the
accepted practice for the language or script in which the
information is given.

http://www.atm.com/
http://www.halcyon.com/pub/journals/21ps03-vidmar
http://www.halcyon.com/pub/journals/21ps03-vidmar
http://home.process.com/Intranets/wp2.htp
http://www.amdahl.com/doc/products/bsg/intra/infra/html
http://www.amdahl.com/doc/products/bsg/intra/infra/html


© 2016-2017 All Rights Reserved, No part of this document should be modified/used without prior consent
Tutors India ™ - Your trusted mentor since 2001
INDIA: Nungambakkam, Chennai – 600 034

UK: The Portergate, Ecclesall Road, Sheffield, S11 8NX

Example:

A. Harriman. (1993, June). Compendium of genealogical
software. Humanist. [Online]. Available e-mail:
HUMANIST@NYVM.ORG Message: get GENEALOGY
REPORT

Basic format for patents (when available online):

Name of the invention, by inventor’s name. (year, month day).
Patent Number [Type of medium]. Available: site/path/file

Example:

Musical toothbrush with adjustable neck and mirror, by L.M.R.
Brooks. (1992, May 19). Patent D 326 189
[Online]. Available: NEXIS Library: LEXPAT File: DESIGN

Basic format for conference proceedings (published):

J. K. Author, “Title of paper,” in Abbreviated Name of Conf., City of
Conf., Abbrev. State (if given), year, pp. xxxxxx.

Example:

D. B. Payne and J. R. Stern, “Wavelength-switched pas- sively
coupled single-mode optical network,” in Proc. IOOC-ECOC,
1985,
pp. 585–590.

Example for papers presented at conferences (unpublished):

D. Ebehard and E. Voges, “Digital single sideband detection for
interferometric sensors,” presented at the 2nd Int. Conf.
Optical Fiber Sensors, Stuttgart, Germany, Jan. 2-5, 1984.

Basic format for patents:

J. K. Author, “Title of patent,” U.S. Patent x xxx xxx, Abbrev. Month,
day, year.

Example:

G. Brandli and M. Dick, “Alternating current fed power supply,”
U.S. Patent 4 084 217, Nov. 4, 1978.

Basic format for theses (M.S.) and dissertations (Ph.D.):

J. K. Author, “Title of thesis,” M.S. thesis, Abbrev. Dept., Abbrev.
Univ., City of Univ., Abbrev. State, year.

J. K. Author, “Title of dissertation,” Ph.D. dissertation, Abbrev. Dept.,
Abbrev. Univ., City of Univ., Abbrev. State, year.

Examples:

J. O. Williams, “Narrow-band analyzer,” Ph.D. dissertation, Dept.
Elect. Eng., Harvard Univ., Cambridge, MA, 1993.

N. Kawasaki, “Parametric study of thermal and chemical
nonequilibrium nozzle flow,” M.S. thesis, Dept. Electron. Eng.,
Osaka Univ., Osaka, Japan, 1993.

Basic format for the most common types of unpublished references:

J. K. Author, private communication, Abbrev. Month, year.
J. K. Author, “Title of paper,” unpublished.
J. K. Author, “Title of paper,” to be published.
Examples:

A. Harrison, private communication, May 1995.
B. Smith, “An approach to graphs of linear forms,” unpublished.
A. Brahms, “Representation error for real numbers in binary

computer arithmetic,” IEEE Computer Group Repository,
Paper R-67-85.

Basic format for standards:

Title of Standard, Standard number, date.
Examples:

IEEE Criteria for Class IE Electric Systems, IEEE Standard 308,
1969.

Letter Symbols for Quantities, ANSI Standard Y10.5-1968.

First A. Author (M’76–SM’81–F’87) and the
other authors may include biographies at the
end of regular papers. Biographies are often
not included in conference-related papers.
This author became a Member (M) of IEEE
in 1976, a Senior Member (SM) in 1981, and
a Fellow (F) in 1987. The first paragraph
may contain a place and/or date of birth (list
place, then date). Next, the author’s
educational background is listed. The
degrees should be listed with type of degree
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